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1. Introduction 

The Works and Accounts Management Information System (WAMIS) is an integrated 

software solution designed to streamline and optimize the management of both works and 

financial processes within a Public Works Department Government of Tamil Nadu. It 

combines tools for managing works, financial transactions, and reporting to ensure efficient 

workflow, accurate tracking, and transparent financial operations. The system also facilitates 

audit trails, enabling transparent tracking of all activities related to project execution and 

financial transactions. 

Key components and features of WAMIS include: 

1. Works Monitoring: The system facilitates the planning, scheduling, and tracking of 

progress on various works. It allows for the addition of work and provides ongoing 

monitoring throughout the work's life cycle, ensuring timely completion.  

2. e-MB (Electronic Measurement Book): This feature enables the digital recording 

and management of Measurement Books, providing accuracy and ease in tracking 

measurements associated with works. 

3. Billing: WAMIS simplifies the billing process by generating accurate and timely bills, 

ensuring proper management of Running Bills and Final Bills. 

4. Department Admin: This module shall enable the creation, management of users 

and roles for access to the application. The users shall be able to access the modules 

as per the prescribed / assigned roles. Users shall be able to perform specific 

functions as per the assigned role. Users can be enabled for more than one module 

depending upon the role assigned. User registration, user authentication, reset and 

change password will be carried out through this module. Further Master Admin 

module facilitates the creation of master data, which serves as the core information 

necessary for system operations and process execution 
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2. System Requirements 

To access and use the Works and Accounts Management Information System (WAMIS) 

effectively, the following system requirements are recommended: 

• Web Browser: A modern web browser with JavaScript enabled is required. 

Supported browsers include: 

o Google Chrome (version 125.0.0.0 or later) 

o Mozilla Firefox (version 128.0.0.0 or later) 

• Hardware: While no specialized hardware is required, the following system 

specifications are recommended for optimal performance: 

o Minimum 4 GB RAM 

o Dual-core processor or higher 

o Stable and reliable internet connection 

These requirements ensure smooth navigation, optimal system response time, and seamless 

access to all WAMIS features. 
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3. Login & Navigation 

Login with login credentials provided for the concerned users for each office. WAMIS 

application UAT URL is https://tnworks-uat.tn.gov.in Actual URL will be provided 

after go-live. 

Step-by-step instructions with Screenshots        

1. Enter the WAMIS URL in the browser. 

2. Enter the “User ID”, “Password” & Captcha 

3. Click on the “Login” button to Login  

4. Reset button to clear text entered in User ID & Password Fields 

3.1. Forgot Password 

If the user forgets the passwords, then using the forgot option, the Password can be reset as 

below. 

Steps : 

1. Click on “Forgot” on the login page as sown in Figure 3.1.1 

2. Enter the “User Id” & Captcha 

3. Click on Send OTP button to receive One Time Password by registered mobile or e-

mail. 

Figure 3.1Login Screen 
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Figure 3.1.1 Forgot Password 

 

 

Figure 3.1.2 Reset Forgotten password 

Change Password  

Go to Profile --> Setting --> Password, as shown in Figure 3.1.3, password screen 

will be displayed as shown in figure 3.1.4 
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Figure 3.1.3 Profile Screen 

After clicking the password menu, the change of password screen will be displayed. 

Users must enter their Old Password, New Password, and Confirm Password. Clicking on 

Change Password validates and updates the password successfully. If the input is incorrect, 

appropriate error messages are shown. The Clear button clears all entered details.  Click on 

the change password button to change the password 

 

Figure 3.1.4 Change Password 
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Field Description: 

Field Name Mandatory  Description Validation 

Old Password Yes It is a User Enterable 

field. 

Enter the old 

password currently in 

use 

. 

New Password Yes It is a User Enterable 

field. 

Enter the New 

password 

1.Password cannot be 

less than 8 characters 

2.Passwords should 

contain at least one 

upper case and 

lower-case 

character, number 

and special 

character. 

Confirm Password 

 

Yes  It is a User Enterable 

field. 

Enter the Confirm 

password 

Reset No To Clear/Erase all 

input field values 

If user wants to cancel 

Change Password 

before click Change 

Password button 

Change Password Yes  To Change Password 

must be clicked 
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4. Module-Based Flow 

4.1. WMS 

This module facilitates the extensive capture of details related to the entire project lifecycle. 

It includes key stages such as Administrative Approval, Estimates, Technical Sanction (TS), 

Agreement Details, and Revised Approvals. The system ensures that all essential data related 

to the project, and its progress are systematically captured, enabling easy retrieval, reporting, 

and analysis. This provides a clear and accurate view of the project’s status, as suggested by 

the concerned department.  

Step-by-step instructions with Screenshots 

WMS comprises core modules: 

1. Work details 

2. Sub Work Details 

3. Tender Details 

4. GO Master 

5. Milestone 

4.1.1. Work details 

The "Work Details" screen in WAMIS is the starting point for project proposals, where all 

relevant project details are captured and managed throughout the project’s progress. To get 

work details follow the procedure as given below navigate to the main menu click on WMS 

Work Details (Figure4.1.1), screen is displayed as shown in below figure (Figure 4.1.1.1). 

The Work Details module comprises the following sub-module to fill in work details: 

 

Figure 4.1 Modules in Work Management System 
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⚫ Office Mapping 

⚫ Work Type 

⚫ DPR Details 

⚫ Estimate 

⚫ GO/AS 

⚫ Head Mapping 

⚫ TS Estimate 

⚫  TS 

 

 

Figure 4.2Work Details Navigation 

After selecting ‘Work Details’ from the menu, we will get an Add section and a View section 

as shown in (Figure4.1.1.2)  

 

Figure 4.3 Work Details (Add) 
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In the Work Management System (WMS), works are generally categorized as New or 

Ongoing. 

• New Work refers works which are initiated through WAMIS 

• Ongoing Work refers to projects that are already in progress or have existing 

agreements. 

Currently, the WAMIS system supports only Ongoing Works; therefore, the selection is fixed 

to Ongoing by default and cannot be modified by the user 

Field Description: 

Field Name Mandatory Description Validation 

Work Number No Auto generated after 

saving. Non-editable 

field. 

System-generated; no 

manual input. 

Work 

Description 

Yes User-enterable 

mandatory field. 

Cannot be blank; 

alphanumeric; max 200 

characters. 

Work Code 

(IFHRMS Work 

Code) 

No User-enterable 

Conditionally 

mandatory field. 

Must follow defined code 

format (e.g., 

alphanumeric) , if Work is 

ported from the IFHRMS, 

Work code 

Work Category Yes Single-select dropdown 

field. 

one option must be 

selected from dropdown 

Program Type Yes Single-select dropdown 

field. 

one option must be 

selected from dropdown 

Work Type Yes Single-select dropdown 

field. 

one option must be 

selected from dropdown 
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Department Yes Single-select dropdown 

field. 

one option must be 

selected from dropdown 

Wing Yes Single-select dropdown 

field. 

one option must be 

selected from dropdown 

District Yes Multi-select dropdown 

field. 

At least one district must 

be selected. 

Taluka/Block Yes Multi-select dropdown; 

depends on District 

selection. 

Select at least one 

corresponding Taluk. 

MLA 

Constituency 

Yes Multi-select dropdown 

field. 

select the MLA 

Constituency the District 

gets auto populated 

MP 

Constituency 

Yes Multi-select drop down 

field. 

Select the MP Constituency 

the District gets auto 

populated. 

Total Length 

(in m) 

No User-enterable numeric 

field. 

Optional field: must be a 

positive number if entered. 

Emergency 

work 

No Click on Check box if the 

work is Emergency 

category 

Optional. 

Land 

Acquisition 

work 

No Click on Check box if the 

work is related to Land 

Acquisition   

Optional. 

Internal works No Click on Check box if the 

work is Departmental / 

Internal work 

Optional. 
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No Technical 

Sanction  

No Click on Check box if the 

work is Technical 

Sanctioned is not 

applicable for the work 

Optional. 

Remarks No User-enterable text 

field. 

Optional; Max 200 words; 

special characters 

restricted. 

Save - Saves the work details. All mandatory fields must 

be valid before saving. 

Reset - Clears all entered work 

details. 

Confirmation prompt 

before clearing. 

 

 

 

Figure 4.4 Work Details (View) 

For the ongoing work in WAMIS before approval, editing of work details is possible, to edit 

details click on the edit   icon action from Work Details View. This will populate the 

relevant details into the Work Details edit form then proceed to the editable form. Once all 
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editing completed then click on Update button to save edited information in Work Details. If 

user want to delete the work details click Trash icon to delete work before approval.  

Note: If user want to do change in work details after approval only EE login user can 

unfinalized the approved work details by click on   icon to undo approved status 

 

Figure 4.5 Work Details Edit ongoing work before approval 

For the works ported from IFHRMS into WAMIS, click on the edit action from Work Details 

View. This will populate the relevant details into the Work Details edit form then proceed to 

the editable form. 
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Figure 4.6 Work Details (Edit - IFHRMS Work) 

4.1.1.1. Office Mapping 

Office Mapping refers to map work under specific administrative offices for works. 

• Select the appropriate offices as per the offices executing the work in the following 

hierarchy in office level. Hierarchical structure like Division → Sub-Division → 

Section. 

• The Nodal Division can initiate the bill if multiple sub-divisions are involved. 

 

Figure 4.7 Office Mapping 
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A Nodal Office is the designated office responsible for coordinating and overseeing specific 

projects, works, or administrative activities within a department or jurisdiction. The Nodal 

Office primary allocating works / project to other divisional offices. In WAMIS, the Nodal 

Office typically acts as the primary point of contact for the execution and monitoring of works 

under its purview. 

Field Description: 

Field Name Mand

atory 

Description Validation 

Office Level Yes A mandatory field with a single 

selectable dropdown representing 

office hierarchy  

Select one valid option 

from the dropdown list. 

Office Name Yes A mandatory field with a single 

selectable dropdown to choose 

the corresponding office name 

under the selected level. 

select one valid office 

name from the dropdown 

list. 

Is Nodal Yes A mandatory Boolean field 

indicates whether the selected 

office is a Nodal Office for the 

work. Work defined by Nodal 

office to sub offices under 

jurisdiction. 

Must be explicitly selected 

(Yes/No); Radio button 

must be selected or 

deselected. 

Actions   

Delete No Contionally to delete mapped 

office entries 

 

Add No To mapp new Office information 

for work 
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Edit No To Edit Office already mapped  

 

4.1.1.2. Work Type 

The Work Type section in the Work Management System (WMS) is used to categorize work 

and define the nature and scope of a project. It is used for collecting information about each 

work is accurately classified based on its type, sub type, classification, and nature of work. 

If the work is ported from IFHRMS, the Work Type will be automatically mapped based on 

the value specified in the Work Details header, as shown in Figure 4.1.6. The Work Type is 

auto selected and cannot be modified by the user.  

 

Figure 4.1.6: Work Type Screen 

If the work is newly added, then the information about the work listed in below field 

description table needs to be entered by user who has the right to create work. If Work is 

ported from IFHRMS then Work Type filed would be auto populated, remaining would be 

manually entered with corresponding values. 

Field Description: 

Field Name Mandatory Description Validation 

Work Type Yes This field is auto populated 

based on the selected work. 

It is mandatory and 

cannot be modified. 
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Work Subtype No Selectable drop-down field that 

provides further granularity to 

the selected Work Type. 

Optional; if selected, must 

be from drop down list. If 

Work is approved, then 

editing of Work sub type 

is not possible 

Classification Yes Multi-select drop down for 

classifying the work under 

various categories. 

At least one classification 

must be selected. 

Nature of 

Work 

No Multi-select drop down field for 

indicating the nature of work 

(e.g., repair, construction, etc.). 

Optional; if selected, 

there must be valid 

options from the drop 

down. 

Chainage 

(000+000) 

No User-enterable text field to 

capture the Chainage location in 

specified format. 

Optional; format must be 

like 123+456; numeric 

only. 

Length (in M) No User-enterable numeric field to 

indicate the work length in 

meters. 

Optional; if entered, must 

be a positive number to 

specify the length / 

distance of the work in 

meters like 

10/100/10000/2569 

Start Lat-Long No User-enterable field to capture 

starting GPS coordinates. 

Optional; format must be 

decimal degrees (e.g., 

12.9716, 77.5946). 

End Lat-Long No User-enterable field to capture 

ending GPS coordinates. 

Optional; format must be 

decimal degrees (e.g., 

12.9716, 77.5946). 
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Save - Saves the current Work Type 

row details. 

All mandatory fields must 

be validated before 

saving. 

Add (icon: "+") - Adds a new row for entering 

additional Work Type details. 

Adds a blank row with 

same field structure. 

Delete - Deletes the selected Work Type 

row from the table. 

Prompts confirmation 

before deletion. 

Edit  To Edit already saved work type 

details by click on pencil icon 

For Editing Work Type, 

must be added and saved 

at least once, if Work is 

Approved then unable to 

edit Work Type 

 

4.1.1.3. DPR Details 

The DPR (Detailed Project Report) Details section in the Work Management System 

(WMS) is used to record technical and financial information about a proposed project. The 

department or external agency preparing the DPR must upload scanned copies of all 

supporting documents. To add a DPR, click the Add DPR button as shown in Figure 

4.1.1.3.1. 

 

Figure 4.8 Add Detailed Project Report (DPR) 

After clicking on Add DPR Button, DPR form will be displayed as shown in Figure 4.1.1.3.2 
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Figure 4.9 DPR Prepared by Department 

 

Figure 4.10 DPR Screen if DPR  prepared by Agency 

Field Description: 
 

Field Name Mandatory Description Validation 

DPR Approval 

Date 

Yes User-enterable date field 

indicating the date on 

which DPR was approved. 

The field is mandatory, 

must contain a valid date, 

and future dates are not 

allowed. 

Amount Yes User-enterable numeric 

field for total DPR amount. 

This field is mandatory and 

must contain a positive 

numeric value; it cannot be 

left blank. 

Prepared by 

Agency 

No Checkbox to indicate if DPR 

was prepared by either 

Agency or Department. 

Optional, (Yes/No). 
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Name Conditional

ly 

Mandatory 

Name of Officer Who 

prepared the DPR  

Required if Prepared by 

Agency is selected as Yes, 

Allow 100 Alphanumeric 

Characters 

Office Name / 

Organization 

Name 

Conditional

ly 

Mandatory 

Name of Agency / 

Organization which 

Prepared the DPR 

Required if Prepared by 

Agency is selected as Yes, 

Allow 100 Alphanumeric 

Characters 

Upload DPR Yes Mandatory file upload field 

to attach the DPR 

document. 

File must be uploaded; 

allowed formats: PDF, 

DOCX; size limited to 

2MB.Total number file for 

uploading limit is 

maximum 5 Nos 

Save - Saves the DPR details 

entered. 

All mandatory fields must 

be validated before saving. 

Reset - Clears all entered DPR 

details. 

Prompts confirmation 

before clearing (optional). 

View DPR - To View already saved DPR 

details 

 

 

After clicking the save click on the View DPR button   then the DPR Details gets saved and 

shows as in Figure 4.1.1.3.4 
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Figure 4.11 View DPR 

 

4.1.1.4. Estimate 

The Estimate section in Work Management System (WMS) is designed to capture the details 

of abstract estimate and Detailed estimate details in the form of components and sub-

components, the financial forecast for a proposed infrastructure project. Estimate section 

collects the following information  

• Estimate Number 

• Estimate Date 

• HSN / SAC for calculating Tax applicable 

• Components  

• Estimate Amount for Components 

• Components estimate amount includes GST or not 

• Is Estimate for Lump sum or not 

Types of Estimates in WMS: 

1. Abstract Estimate: 

A summary-level estimate outlines the major components and sub-components of the 

work without item-wise cost details. 

2. Detailed Estimate: 

A comprehensive estimate that includes rate analysis and item-wise costing for each 

component and sub-component, based on quantity and unit rates. 
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Click on the Estimate tab and click on Add Estimate button as shown in Figure 4.1.1.4.1 

 

Figure 4.12 Add Estimate 

After clicking on Add Estimate button, the estimate form will be displayed as shown in Figure 

4.1.1.4.2. 

Fill the Estimate Number, Select Estimate Type, Select Date of estimate and HSN/SAC then 

click on Save Button 

 

Figure 4.13 Add Estimate 

 Field Description: 

Field 

Name 

Mandat

ory 

Description Validation 



Works and Accounts Management Information System, User Manual  

     

26 
 

Estimate 

Number 

Yes User-enterable field for 

entering the estimate reference 

number. 

Max 50 characters; allows 

letters, numbers, slashes ( / ), 

and hyphens ( - ). 

Estimate 

Type 

Yes Radio buttons provided for 

selecting the estimate type as 

Abstract / Detailed (e.g., 

Detailed, Abstract). 

One option must be selected 

for Estimate Types; those are 

Abstract and Detailed. 

Abstract estimate consists of 

components and sub-

components, while Detailed 

estimate consists of estimate 

items. 

Estimate 

Date 

Yes User-enterable date field for 

the estimate creation date. 

Must be a valid date; cannot 

be blank; future dates may be 

restricted. 

HSN/SAC Yes User-selectable drop-down 

field for selecting the 

appropriate HSN/SAC code. 

Must select one valid 

HSN/SAC code from the drop 

down to get applicable 

CGST/SGST/IGST in percentile 

of the amount. Example 18 % 

,12 % 

CGST No Auto-calculated tax value 

based on selected HSN/SAC. 

System-calculated; read-only. 

SGST No Auto-calculated tax value 

based on selected HSN/SAC. 

System-calculated; read-only. 

IGST No Auto-calculated tax value 

based on selected HSN/SAC. 

System-calculated; read-only. 

Save - Saves the Estimate Details. All mandatory fields must be 

validated before saving. 
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Reset - Clears all entered Estimate 

Details 

Confirmation prompt before 

resetting (optional). 

After clicking on view estimate. Entered details will be displayed as shown in Figure 

4.1.1.4.3 

 

Figure 4.14 View Estimate 

Click on the + icon to Add Component pop up window will appear as shown in Figure 

4.1.1.4.4 to input each component’s details like components name, estimated Amount for 

the component etc., then click on flappy icon to save component, after saving 

component edit  and delete action  icons will appear. To submit the Estimate related 

document, click on arrow icon 
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Figure 4.15 Add Component 

 

Field Description: 

  Field Name      Mandatory    Description Validation 

Component 

Name 

Yes Selectable drop-down 

field to choose the 

component name. 

Select one valid option must 

be from the drop down. 

Amount No User-enterable numeric 

field for component 

amount. 

There must be a positive 

number if entered; decimals 

allowed.   

Is LS (Lump 

Sum) 

No Checkbox provided to 

indicate if the amount is 

Lump Sum. 

Optional. 

Include GST No Checkbox to include GST 

in the component 

amount. 

Optional; if checked, GST is 

calculated and applied 

based on rules. 
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Remarks No User-enterable text field 

for additional comments. 

Optional; alphanumeric; 

character limit as defined 

(e.g., 200 chars). 

Add Sub-

component + 

- User click on + icon 

Opens a pop-up window 

to add sub-component 

details under this 

component. 

Pop-up must replicate 

structure with appropriate 

validations. 

Save - Saves the component 

details. 

All mandatory fields must 

be validated before saving 

components details 

Delete  
- Deletes the selected 

component entry. 

Confirmation required 

before deletion. 

Edit  - To edit details of the 

component already 

saved 

Click on icon 

Click on the Add Subcomponent          icon you a pop up will appear as shown in Figure 4.1.1.4.5 
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Figure 4.16 Add Subcomponents 

Field Description: 

Field Name Mandatory Description Validation 

Component Name Yes Drop down populated based 

on the selected main 

component. 

Must select a valid 

component; auto 

linked from the 

Component section. 

Subcomponent No User-enterable text field for 

the sub-component name. 

Cannot be blank; 

alphanumeric; max 

100 characters. 

Amount No User-enterable numeric field 

for sub-component cost. 

Optional; if entered, 

there must be a 

positive number 

(decimals allowed). 

Amount Estimated 

for sub component 

should not exceed 
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estimate amount of 

main Component 

Remarks No User-enterable character field 

for additional 

comments/details. 

Optional; 

alphanumeric; max 

200 characters.  

Actions Save Yes To Save Subcomponent 

Details 

Click on 

icon 

Edit No To edit details of the 

subcomponent already saved 

Click on icon 

Delete No To Delete subcomponent Click on  icon and 

accept confirmation 

before deletion. 

Note: Total of all Sub-Component amount should not exceed the estimate amount of the 

component 

 Users will be able to see the overall Total Estimate Components Added Value and its 

respective amount, including GST, as shown in Figure 4.1.1.4.6, after clicking the Close button 

in the pop-up window once all components have been added, as shown in Figure 4.1.1.4.4. 

 

Figure 4.17 Total estimate value 

If any supporting documents are available, click on icon under column named Upload 

Docs and upload the necessary documents. Documents should be satisfied with the 

validation conditions as follows 

• File size less than 1 MB in PDF format document 

• Maximum 5 files are allowed for uploading 



Works and Accounts Management Information System, User Manual  

     

32 
 

• Each filename should be different  

 

4.1.1.5. GO/AS 

• GO: Government Order 

• AS: Administrative Sanction 

Together, GO/AS refers to the approval issued by the Government as Order for the work. 

Work Initialization: 

For any Ongoing work, Government Order / Administrative Sanction details to be registered 

in WAMIS system. GO Master needs to be mapped with corresponding Head of Account for 

the work. 

• GO/AS details (like number, date, amount, file number) are recorded while adding a 

work. 

• Tender amount should not exceed GO/AS Sanction amount 

• If the work is ported from IFHRMS then the data for the GO/AS auto populated 

Click on the GO/AS Tab you will be able to see the GO/AS mapped to the work as shown in 

Figure 4.1.1.5.1 

 

Figure 4.18 GO/AS 

4.1.1.6. Head Mapping 
Head Mapping refers to linking a work/project to Head of Account for the department to take 

a specific financial. In the GO (Government Order) Master screen, Head mapping refers to 

the process of linking a Government Order to the appropriate Officer as Head of account 

under which funds are allocated for a specific work. Head Mapping happening two levels 

1. Chief Engineer / map Head with corresponding Government Order (GO) 

2. Head Mapping for work details 

 

Login using the CE credentials, go to WMS →select GO Master,→ map the Head of Account 

by selecting the relevant GO and adding the appropriate head details as shown in figure 4.19. 

If Work ported from IFHRMS then all GO/AS Head Mapping will be appeared in respective 

section of work details. 



Works and Accounts Management Information System, User Manual  

     

33 
 

 

 

Figure 4.20 GO/AS & Head Mapping for work 

To get works Head mapping after GO/AS & Head Mapped for the work Click on the Head 

Mapping Tab to get the Head Mapping information shown as shown in the Figure 4.1.1.6.3. 

 

Figure 4.21 Head Mapping 

If the work is ported from IFHRMS then the data gets auto populated. If the work is new, then 

the Head Mapping will be assigned by the Officer,  

4.1.1.7. TS Estimate 

The TS (Technical Sanction) Estimate is a formal approval for the cost estimates for 

Material Machineries to be used for the work / project. WAMIS collects the following 

information under Technical Sanction Estimate 

• Estimate Number 

• Estimate Type 

• Estimate Date 

• Total Estimate Amount  

• Components  

• Documents for TS Estimate 
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Click on the TS Estimate tab you will be able to view / add TS Estimate as shown in Figure 

4.1.1.7.1 

 

Figure 4.22 Add TS Estimate 

After clicking on Add Estimate, Add Estimate form will be displayed with the following 

fields as shown in Figure 4.1.1.7.2 

 

 

Figure 4.23 Adding TS Estimate Details 

Field Description: 
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Field 

Name 

Mandatory Description Validation 

TS 

Estimate 

Number 

Yes User-enterable field for 

entering the estimate reference 

number. 

Max 50 characters; allows 

letters, numbers, slashes (/ ), 

and hyphens (- ). 

TS 

Estimate 

Type 

Yes Radio buttons provided to 

select the type of estimate (e.g., 

Abstract, Detailed). 

One option must be selected. 

Abstract Estimate – To show 

Estimate in High Level for 

Components  

Detailed estimate for each 

Components  

TS 

Estimate 

Date 

Yes User-enterable field for the 

date the estimate is created. 

Must be a valid date; cannot 

be blank; future dates may be 

restricted. 

HSN/SAC Yes Drop down field to select the 

relevant HSN/SAC code for tax 

classification. 

Users must select one valid 

code from the drop-down list. 

To include respective 

percentile of Tax addition to 

estimated amount for TS 

Estimate 

CGST No Auto-calculated Central GST 

based on the selected HSN/SAC 

code. 

It is system-generated and 

read-only. 

SGST No Auto-calculated State GST 

based on the selected HSN/SAC 

code. 

It is system-generated and 

read-only. 
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IGST No Auto-calculated Integrated GST 

based on the selected HSN/SAC 

code. 

It is system-generated and 

read-only. 

Save - Button to save all entered 

Estimate Details. 

All mandatory fields must be 

validated before saving. 

Reset - Button to clear all entered 

Estimate Details. 

Optional confirmation prompt 

before clearing (based on UI 

design). 

 

After clicking on view estimate, entered details will be displayed. 

Click on the plus icon Add components and view or modify the components present in the 

Components section. 

 

Click on the plus  icon Add components and view or modify the components present in 

the Components section and in sub-components section as shown in the Figure 4.1.20 

 

Figure 4.1.20:  TS Components 

 

 Click the Add Component button to add new components. 

 

                                                                             

Click the Add Component button to add new components. 

 If a component has sub-components, click the  icon to display the sub-component popup 

screen. 

Figure 4.24 View TS estimate 

Figure 4.25 Add Component / Sub Component 



Works and Accounts Management Information System, User Manual  

     

37 
 

Enter the sub components details in the below screen as shown in the Figure 4.1.1.7.5 Sub 

Components and save the sub components popup screen. 

 

Figure 4.26 Sub Component 

If the sub-component has any TA (Technical Approval), add it by clicking the Add TA icon. 

Close the sub-component popup screen, and you will appear as a Add TA icon on the 

component screen. 

Click the Add TA + icon on the component screen to add the TA details for the sub-   

component, as shown in Figure 4.1.1.7.6. 
 

 

Figure 4.27 Add TA 

After click the add TA icon in the component screen the popup screen will be displayed as 

shown in the figure 4.1.1.7.7               

Enter the TA details for the sub components and click the save button. 

Close the popup window displayed, you will be able to see the final TS Estimate Amount for 

the components to be proceeded in the TS as shown in Figure 4.1.1.7.8. The Cumulative 

amount for all subcomponents is less or equal to the TS estimate amount. 

Figure 4.28 TA screen 
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Figure 4.29 : View TS ESTIMATE 

Here the components, A Sanction Amount are populated from the Estimate tab screen. 

Field Name Mandatory Description Validation 

Sub Component Yes It is user enterable 

filed 

Enter the sub 

component name 

for the component 

Amount Yes It is user enterable 

filed 

Enter the amount is 

less or equal to the 

TS estimate amount. 

TA Date Yes It is user enterable 

filed 

Enter the TA date 

for the 

subcomponent 

TA No Yes It is user enterable 

filed 

Enter the TA No for 

the subcomponent 

TA Amount Yes It is user enterable 

filed 

Enter the TA 

Amount for the 

subcomponent 

Edit    No Click the edit icon to 

update the 

components/sub 

components and TA 

details. 

 

Delete No Click the delete icon 

to clear/delete the 

components/sub 

components and TA 

details. 

 

 

4.1.1.8. TS 
TS stands for Technical Sanction. It is an official approval granted by a competent authority  

Click on the TS TAB. User will be able to see an add TS button as shown in the Figure 4.1.1.8.1 
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Figure 4.30 Technical Sanction 

Click on Add button User will be able to see a TS form as shown in Figure 4.1.1.8.2 

 

Figure 4.31 TS Form 

Field Description: 

Field Name Mandatory Description Validation 

TS Order 

Number 

Yes User-enterable field for the 

official TS reference/order 

number. 

Alphanumeric; must not be 

blank; max length limit as per 

system (e.g., 50). 

TS Date Yes Date field to select the date 

of Technical Sanction 

issuance. 

Must be a valid past or present 

date; cannot be left blank. 

TS Year Yes User-selectable field 

indicating the sanction 

year. 

Must be selected from a valid 

year range; cannot be left 

blank. 

TS Zone Yes User-enterable field 

indicating the applicable 

zone. 

Alphanumeric; required; 

predefined zone names may 

be validated if applicable. 

TS Amount 

(inclusive of 

GST) 

Yes Numeric field for total 

sanctioned amount 

including GST. 

Positive number; mandatory; 

decimal values allowed. 
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TS Office Yes User Selectable field, Select 

the office responsible for 

TS. 

Cannot be blank; Select the 

office from the dropdown list 

of the options 

Save Yes To save Technical Sanction 

information  

 

Reset No To Clear filled Information  

View TS  To view the TS information 

saved already 

 

Click on view TS button user will be able to see a Technical Sanction of the work with 

details as shown in Figure 4.1.1.8.4. 

 

Figure 4.32 View TS 

APPROVE WORK DETAILS 

To review and approve the work details and associated estimates added in the Work 

Management System (WMS), follow the steps below: 

1. Login to WMS Portal using your appropriate credentials. 

2. Navigate to the Work Management System section and click on the "View" tab. 

3. From the displayed list, identify the work you wish to approve. 

4. Under the "Action" column, click the Edit icon to open and modify the work details, 

if necessary. 

5. Click the Eye icon under the "Final Approval" column to generate and preview 

the Work Details, as shown in Figure 4.1.1.8.4 
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Figure 4.33 View Final Approval of Work Details 

Click on the eye icon the report preview will display all entered work information 

shown in Figure 4.1.1.8.4 

 

 

 

Figure 4.34 Preview Page of Work Details 
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Click on the Approve button to Approve the Work Details, The Approver should validate all 

information before approving work details. If once the Work Details View Tab is Approved, 

the User won't be able to edit or modify.  

4.1.2.  Sub Work Details 

Sub-Work Details refer to the smaller, clearly defined components of a main work. 

Sub-Works are created based on the agreements that are planned or already executed 

for ongoing works within the Work Management System (WMS). 

 

To access the Sub work Details, navigate to WMS -> WORK -> SUB-WORK DETAILS 

Click on the Sub-Work Details user will be able to see an ADD/VIEW TABS 

 

Click on the ADD button and the user will be able to see a form as shown in Figure 4.1.2.1 

 

Figure 4.35 Add Sub-work Details 

Field Description: 

    Field Name Mandatory Description Validation 

  Parent Work Yes Drop down to select the main 

parent work from the list of 

approved works. 

Must select a valid entry from 

the drop down cannot be left 

blank. 
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Sub Work Number Yes Auto Populated Sub Work 

Number 

Alphanumeric; must be 

unique; max length as per 

system (e.g., 50 characters). 

Sub Work 

Description 

Yes Text area for entering a 

description of the sub-work 

(max 500 characters). 

Cannot be left blank; character 

limit: 500; alphanumeric with 

special symbols & () _-/ , .' ". 

Amount for Tender Yes User-enterable numeric 

field specifying the tender 

value of the sub-work 

Amount must be a positive 

number; decimals allowed; 

mandatory field. Tender Amount 

should not cross the cumulative 

of all components Technical 

Sanctioned Estimate Amount for 

the work 

Amount for 

Tender (Including 

GST) 

No Auto-calculated 

automatically based on 

HSN/SAC field based on the 

"Amount for Tender". 

System-calculated; read-only; 

includes applicable GST rate. 

Amount for Tender including 

GST = Tender Amount+ (% of 

GST Select in HSN/SAC Code) 

HSN/SAC code defined in 

Master of WMS Module time to 

time as per rule to describe the 

Tax percentile for applicable 

GST over amount  

 

Note: The Amount for Tender (Including GST) should not exceed GO/AS amount 

Based on selection of the Parent work automatically the mapped components will be 

displayed as per components added in Technical Sanction shown in Figure 4.1.2.2 
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Figure 4.36 Map Components 

Click on the necessary components and enter the respective Current Tender Amount. The 

amount entered for each component or sub-component must not exceed its available Balance 

Tender Amount. The total tender amount should be less than or equal to the cumulative 

Balance Tender Amount of the selected components. 

 

Field Description: 

Field Name Mandatory Description Validation 

Include 

Components 

No Checkbox list to select 

applicable components (e.g., 

Civil Work, External Electrical 

Work). 

Selecting components 

enables the relevant TS and 

tender fields. 

TS Sanction 

Amount 

No (Read-

only) 

Numeric field showing the 

sanctioned amount for each 

component. 

Read-only, fetched from TS 

sanction details; cannot be 

modified. 

Previously 

Tendered 

Amount 

No (Read-

only) 

Shows previous tendered 

values against the selected 

component. 

Read-only, fetched from 

earlier tender records. 

Current Tender 

Amount 

Yes User enterable field indicating 

the current tender value per 

component. 

Must be a valid positive 

number if component is 

selected. 
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Balance Tender 

Amount 

Auto Auto-calculated field: TS 

Sanction Amount – (Previous + 

Current Tendered). 

Read-only, updated 

dynamically based on 

entries for the respective 

components. TS Sanction 

Amount – (Previous + 

Current Tendered). 

Save - Button to save the mapped 

tender component values. 

All mandatory entries must 

be valid; triggers back end 

validation if required. 

The Sub Work Details module comprises the following sub-modules, which optional 

for enter data:  

⚫ Office Mapping 

⚫ TS 

 

4.1.2.1. Office Mapping 
Office Mapping refers to categorizing work under specific administrative offices for all type 

of construction and non-construction works. For sub works office mapping is not mandatory. 

Among the offices already mapped on parent work, only selective offices that will be 

executing the sub work can be mapped under this section. Sub Office mapping must be 

created by the Officer who has authorization to assign sub-work to Sub-Offices. Then Sub-

Office work estimates, and Technical Sanction would be submitted to Approval Authority 

(Parent office) 

If office mapping on sub work is skipped, all the offices mapped on parent work will be 

mapped on sub work as well. 

4.1.2.2. TS 

Technical Sanction for sub works is a non-mandatory section. If a new TS is taken for sub 

work, those details can be entered in this section, If TS is taken on a sub-work separately 

(Mostly for LS components). 

 APPROVE SUB WORK DETAILS 

 Once the Save button is clicked after entering the Sub Work details: 

• Navigate to the View section,  

• Locate the Final Approve column and click on tick mark icon 

• To Unfinalized the Sub work details after approval click on  icon 



Works and Accounts Management Information System, User Manual  

     

46 
 

• To edit Sub Work information, click on pencil  icon  

• To Delete the sub-work, before approval by click on Trash icon  

• Click on Tick Mark icon in the column to approve the Sub Work as shown in the image 

Figure 4.1.2.2.1 

 

Figure 4.37 View Sub Work 

4.1.3. TENDER 

A Tender in WMS refers to the recording of documents related to a Tender awarded to 

contractors who have won the bidding for a specific work/contract. It includes capturing all 

necessary information such as package, value, dates, and award details. To Capture NIT 

(Notice Inviting Tender), EMD, Corrigendum, and final award. 

• Ensure transparency in work allocation. 

The Tender Details module comprises the following sub-modules 

⚫ NIT 

⚫ Awarding 

Navigate this module by clicking WMS → WORK → TENDER Details and Click on Add Tab it 

will display as shown in Figure 4.1.3.1 
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Figure 4.38 Tender Details 

 

Field Description: 

Field Name    Mandatory         Description         Validation 

Tender No. Auto Unique ID automatically 

generated after saving 

the tender details. 

It is system-generated and read-only. 

 

Package No. Yes User-enterable field to 

specify the package 

number. 

Enter the values.  

Tender Work 

Name 

Yes User-enterable field to 

name the tendered work. 

Enter the name max 100–200 

characters. 

Tender Type Yes User-selectable drop 

down for selecting the 

type of tender like. Item 

Rate, Percentage and EPC 

Select from the drop down. Only 

following type of Tender is applicable 

only in Tamil Nadu, those are Item 

Rate, Percentage, EPC  

Split Works Yes Multi-select drop down 

to choose split works 

from approved sub-

works. 

Must select at least one; populated 

from approved sub-work list. 
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Tender Amount Yes Calculated value is 

displayed but is editable. 

. 

It must be a positive number 

(decimals allowed) and is read-only; 

not editable by the user. 

Is HSN/SAC 

Common? 

No Checkbox indicating 

whether a common 

HSN/SAC code applies 

across all works. 

Optional; if GST is applicable then 

must be selected/ checked to select 

corresponding HSN/SAC code to be 

selected works. 

If not selected / checked HSN/Sac 

code is not visible 

 

Click on the save tab. It will automatically create a Tender Number. 

4.1.3.1. NIT  

In WAMIS, the NIT section captures key details such as NIT Number, NIT Date, EMD 

Amount, Tender Submission Dates, and other basic tender-related information required 

for processing the tender. Click on the Add NIT button an NIT form will be displayed as shown 

in Figure 4.1.3.1.1 

 

Figure 4.39 Add NIT for Tender 

 Field Description: 

Field Name Mandatory Description Validation 

NIT No. Yes User-enterable field for 

entering the unique NIT 

reference number. 

Alphanumeric; must not be 

blank; max character limit (e.g., 

50 chars). 
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NIT Date Yes Date field to select the date 

of NIT issuance. 

Must be a valid past or present 

date; cannot be blank. 

Submission Date No Date field for selecting the 

last date to submit the 

tender. 

Must be a valid future date; 

optional. 

Closing Date No Date field indicating the tender 

closing date. 

Must be a valid date; should be 

after Submission Date if both are 

filled. 

EMD Value Yes User-enterable numeric field 

for Earnest Money Deposit 

amount. 

Must be a positive number; 

decimals allowed; cannot be 

blank. 

Special 

Conditions 

No Dropdown to choose 

predefined tender-specific 

conditions. 

Optional; selection from 

predefined list. 

Upload NIT 

Notice 

Yes    Upload field for attaching the 

NIT document (PDF or doc). 

     File upload required; only 

allowed formats; file size 

restrictions may apply. 

Save - Button to save the entered 

NIT details. 

All mandatory fields must be 

validated before saving. 

Reset - Button to clears all user-

entered NIT details. 

Button to clear user inputs. 

 

Click on the view NIT button it will display the entered details as shown in Figure 4.1.3.1.2 
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Figure 4.40 View NIT 

4.1.3.2. AWARDING 

The WAMIS system is used to capture details related to the selection of the winning 

bidder and the issuance of the agreement. The awarding process itself is carried out 

externally; WAMIS is used only to record the finalized information. It captures details 

related to the awardee, as shown in Figure 4.1.3.2.1. 

Click on the Awarding tab, Awarding Tab UI will appear as shown in Figure 4.1.3.2.1 

 

Figure 4.41 Tender Awarding 

Click on the Add Awarding button, Awarding Tab form will appear as shown in Figure 

4.1.3.2.2 

 

Figure 4.42 ADD AWARDING 
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Field Description: 

 

Field Name Mandatory Description Validation 

Agreement No. Yes User-enterable unique 

agreement number. 

Alphanumeric; cannot be 

blank; max character limit 

as per system. 

Agreement Date Yes Date field to select the 

agreement signing date. 

Valid date; must be past or 

current date; required 

field. 

LOA Date Yes Date of issuance of Letter of 

Acceptance (LOA). 

Valid date; must be before 

or equal to Agreement 

Date. 

Start Date Yes Work commencement date. Valid date; cannot be 

blank. 

Duration (Days) Yes Duration of work in 

number of days. 

Must be a positive integer; 

required field. 

Stipulated End 

Date 

Auto/User Auto-calculated as Start 

Date + Duration; editable if 

necessary. 

Auto filled if duration and 

start date present; 

optionally editable. 

Quoted Per Type No Drop down to select 

quotation type (At Par, 

Less, Above.). 

 Select from list. 

Quoted Percent Yes User-enterable numeric 

field for contractor's 

quoted percentage. 

Must be a number (can be 

negative for below); 

mandatory field. 
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Is Common Quote? No Checkbox indicating the 

same % applies to all items. 

This is applicable only for 

Tender Type as Percentage 

Optional; affects 

calculation logic. 

Payee Yes Drop down to select 

registered contractor. 

select from contractor to 

whom work is awarded by 

bidding. 

 

Authorized 

Signatory Name 

No Name of the signatory 

authorized to represent the 

contractor. 

Alphanumeric; optional; 

character limit as per 

system. 

Authorized 

Signatory 

Designation 

No Designation of the 

authorized signatory. 

Optional; character limit 

applies. 

Total Security 

Deposit 

No Numeric field to specify 

total security deposit 

amount. 

Optional; must be a 

positive number if 

entered. 

Is Eligible for 

Mobilization 

Advance? 

No Checkbox to enable 

mobilization advance. 

Optional; if selected, next 

field becomes visible. 

Mobilization 

Advance in 

percent of amount 

Conditional Radio button shown only if 

the above checkbox is 

checked. 

Must select a mode (e.g., % 

of contract, fixed amount) 

if enabled. 

Upload of 

DD/BG/FSD 

Yes File upload for Demand 

Draft / Bank Guarantee / 

FSD documents. 

Mandatory; accepted 

formats: PDF, DOC; max 

file size rules apply. 
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Default Liability 

Period 

No Numeric field for default 

liability period (in days). 

Optional; must be a valid 

number if entered. 

Is Measurement 

Required? 

Yes Dropdown (Yes/No) to 

confirm if measurement 

process is needed. 

 select Yes or No. If User 

Select Yes, then e-MB for 

filling measurement book 

is mandatory, otherwise E-

MB is not required, e-

Billing is required for 

Items without 

measurement 

Save - Button to save entered 

awarding details. 

All mandatory validations 

must be passed before 

saving. 

Reset - Button to undo or clear the 

entered awarding details. 

Optional confirmation 

dialog; clears current form 

inputs. 

Click on the View Awarding button, entered details will appear in tabulated as shown in 

Figure 4.1.3.2.3 

 

 

Figure 4.43 View AWARDING DETAILS 

Refer figure 4.1.3.2.3 Where a column labeled Upload BOQ is displayed. For every sub-work 

included in the tender, there is a field to capture BOQ items and amendment details, 

organized under sub-work sections.  
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To upload BoQ click on the + icon present in the ITEM sub split of BoQ. It will display a pop 

up as shown in Figure 4.1.3.2.4 

 

Figure 4.44 Upload BoQ 

Field Description: 

Field Name Mandatory Description Validation 

HSN/SAC Yes HSN/SAC; HSN/SAC is auto set  HSN/SAC; HSN/SAC is auto 

set if user has selected a 

HSN/SAC percent while 

entering Tender details, or 

else it is open for selection. 

Quote (%) No Auto populated value of 

Quoted percentage. Quoted 

Percentage filled as per Quoted 

Percentage Type 

-  

Schedule 

Name 

Yes Drop down to select the 

schedule group (e.g., Schedule 

A). 

Must choose from 

predefined list; cannot be 

blank. 

Item Code No User-enterable item number or 

code. 

Optional; alphanumeric; 

max length as defined. 
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Item 

Description 

Yes Description of the BOQ item 

(e.g., LABOUR, MATERIAL). 

Cannot be blank; max 250 

characters; alphanumeric 

with special characters 

allowed. 

Unit Yes Unit of measurement for the 

item (e.g., NOS, SQM, Litre). 

Cannot be blank; must select 

from defined unit list. 

Rate No Estimated/base rate per unit 

provided by the department. 

Optional; numeric; may be 

used for comparison 

purposes. 

Rate by 

Bidder 

No The quoted rate entered by the 

bidder per unit. 

Optional; numeric; must be 

positive if entered. 

Rate by Bidder column is 

displayed only for Item Rate 

type of tenders 

Quantity Yes Total quantity/units for the 

BOQ item. 

Cannot be blank; numeric; 

must be a positive number. 

Amount 

(INR) 

Auto Total amount = Rate by Bidder 

× Quantity. For Tender type is 

item rate calculated per item 

rate quoted by bidder, if tender 

type is Percentage calculated 

based on percentage  

Auto calculated; read-only 

field. 

Actions - Buttons to Add (+) or Delete 

(🗑) individual item rows. 

Operational UI controls for 

row-level editing. 

Save All - Save all entered BOQ item 

details. 

Ensure all mandatory fields 

validated before saving. 
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Reset - Clears all entered fields in the 

form. 

Confirmation popup before 

clearing (optional, UI-

dependent). 

Download 

Template 

- Downloads an Excel template 

for bulk BOQ entry. 

Template format must 

match upload structure. 

Upload Excel - Uploads Excel file to bulk 

insert BOQ items into the 

system. 

Validates file structure, 

format, and data before 

insertion. 

After entering or uploading the BOQ (Bill of Quantity) Items, click "Save All" to ensure all 

items of BOQ are stored in the system. Once saved, close the BOQ Item pop-up window and 

navigate back to the Split Work List or main table view. 

In the "Action" column corresponding to the relevant split work entry, click on the tick mark 

[  ]icon to approve the BOQ. This confirms that the BOQ details are finalized and locked for 

further processing. As shown in Figure 4.1.3.2.5 

 

 

Figure 4.45 Approve Awarding 

Note: Once Awarding is Approved, we won't be able to edit BoQ and other details. 

4.1.3.2.1. Amendments  

Amendments in awarding include registering the expiration of time, deviations, and 

supplement items or item details of the work after approval of the awarding. The WAMIS 

system has the following types of amendments available: 

• EOT 

• Deviation 

• Supplements Items 
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4.1.3.2.2. EOT-Extension of Time 

EOT for register the details and document proof of EOT request and approval for the Work’s 

completion date extension 

 

Figure 4.46 Extension of Time (EOT) Amendment 

Field Description: 

Field Name Mandatory Description Validation 

Extension 

Initialization 

Date 

Yes Select date of Extension 

initialized for work 

Choose date from Calendar 

panel,  

Stipulated 

Date of 

Completion 

Yes Auto Populated date as Actual 

date of completion as per 

Tender Agreement, while 

awarding registered for work 

Existing Date of 

Completion selected initial 

Awarding 

Extension Up 

to Date 

Yes Select date of new date of 

completion for the work 

Choose date from Calendar 

panel 
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Detailed 

Reason for 

Extension 

Yes Enter description about reason 

for extension 

Maximum length 500 

Characters 

Extension 

Approval No 

Yes User enterable field for fill 

extension approval number 

Cannot be blank; max 20 

characters; alphanumeric 

with special characters “/ - 

“allowed. 

Approving 

Authority 

Yes Select approving Authority 

from the dropdown list 

Cannot be blank; must 

select from defined drop-

down list. 

Approval 

Date 

Yes Select Approval Date Select approval date from 

calendar 

Is Price 

Variation? 

Yes Select either Yes or No option, 

if price variations is there click 

on Yes otherwise No 

Select one option must 

Fine Levied? Yes Select either Yes or No option Select one option must 

Actions - Buttons to Add (+) or Delete 

(🗑) individual item rows. 

Operational UI controls for 

row-level editing. 

Fine Levied 

In? 

Conditionally 

Mandatory 

If Fine Levied is selected as 

Yes, then fine levied as percent 

or amount will appear in 

screen 

Select one option either 

Percent or Amount 

Is Fine 

deducted 

Conditionally 

Mandatory 

If Fine Levied is selected as 

Yes, then fine deducted or not 

option will; be appeared in 

Select one option either 

Yes or No 
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screen. If yes fine deducted, 

otherwise select No 

Save All - Save amendment details. Ensure all mandatory 

fields validated before 

saving. 

Reset - Clears all entered fields in the 

form. 

 

 

 

Figure 4.47 View of EOT 

Field Description: 

Field Name Mandatory Description Validation 

Extension 

Approval No. 

- Select date of Extension 

Approval No for BoQ 

amendment  

Auto Populated  

Extension 

Initialization 

Date 

- Date of Extension Initialization Auto Populated  

Extension 

Approval 

Date 

- Select date of Extension 

initialized for work 

Auto Populated  
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Status - Status of Extension of Time 

will be displayed 

Based on Approval and 

Registration of EOT 

Attachments - To Upload scanned copy of the 

documents for approval 

granted for EOT 

Scanned file in PDF format 

of size 1MB, Maximum 5 

files are allowed for 

upload 

Action Yes   

Edit - To edit already added EOT 

details 

Editing is possible only 

before approve the 

amendment 

Delete - To delete already added EOT 

details 

Deletion is possible only 

before approve the 

amendment 

Approve Yes Approve the amendment detail 

in the EOT form. 

Mandatory to extend EOT  

 

4.1.3.2.3. Deviation Registration for BOQ Items 
If the BOQ contains any deviation in the quantity of SOR or Non-SOR items, the corresponding 

amendment details must be registered in the WAMIS system after the approval of the award. 

The following information is required to be entered in the system during deviation 

registration: 

• Deviation Initialization Date 

• Approval Number 

• Approving Authority 

• Approval Date 
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Figure 4.48 Update Deviation in amendment of BoQ in Awarding 

After add deviation of BOQ items needs to be approved in View Tab by click on Tick Mark  

 

Figure 4.1.3.2.3.2 View Deviation for BOQ amendment 

Field Description: 

Field Name Mandatory Description Validation 

Deviation 

Initialization 

Date 

Yes Select date of Extension 

initialized for work 

Choose date from Calendar 

panel,  

Deviation 

Approval No 

 

Yes Approval Number for 

Deviation  

Alphanumeric Value  
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Approving 

Authority 

Yes Selectable option from 

drop-down list of 

approving authority 

Select one appropriate 

approving authority 

Deviation 

Approval Date 

Yes Date of approval for the 

deviation 

Select date from Calendar 

tool 

Save Yes Clickable button to save 

the Deviation approval 

details 

 

Reset No To Clear input field values  

Deviation Item Yes Clickable button to get 

existing Non-SOR / SOR 

Items 

Must be fill the deviation 

item 

Select Yes Click on check box to 

select item which having 

deviation 

Check on check box 

Add Item Yes To add selected items for 

fill the deviation  

Item Must be selected and 

click on button  

Schedule 

Name 

yes Schedule of the item, auto 

populated from BoQ 

 

Item code yes Item code auto populated 

from BoQ 
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Item 

description 

yes Item Description auto 

populated from BoQ 

 

Unit Yes Measurement Unit of an 

item populated from BoQ 

Unit of measurement in 

character 

Rate Yes Rate of an item auto 

populated 

Item rate in Number 

Quantity Yes Existing Quantity of an 

item populated from BoQ 

Quantity in number 

Amended Qty Yes New / Deviated Quantity 

of an item to be entered 

by user 

Quantity in number 

Amount (INR) Yes Auto populated values 

based on calculation 

Rate*Amended Quantity 

Amount in number with 2 

decimal points 

 

4.1.3.2.4. Supplement Item 
Amendment of Supplement Items is used to add additional item details or include new items 

used for completing the work after the tender has been awarded. An Extra item may be Non 

SOR / SOR Item, The Supplement Item Amendment Information shall be updated as per the 

item details as follow: 

• Non-SOR / SOR Item Code 

• Item Description 

• Rate 

• Quantity 

• Unit 

• HSN/SAC Code 

• Quoted Percentage (%) 
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Figure 4.49 Amendment of Supplement Items 

Field Description: 

Field Name Mandatory Description Validation 

Suppliment 

Item 

Initialization 

Date 

Yes Select date of Supplement 

Item initialized for work 

Choose date from Calendar 

panel 

Suppliment 

Item Approval 

No 

Yes Approval Number for 

Supplement item approval 

Alphanumeric Value 

Approving 

Authority 

Yes Selectable option from 

drop-down list of 

approving authority 

Select one appropriate 

approving authority 

Suppliment 

Item Approval 

Date 

Yes Date of approval for the 

Suppliment Item 

Select date from Calendar 

tool 

Save Yes Clickable button to save 

the Deviation approval 

details 
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Reset No To Clear input field values  

Suppliment Items as either Non-SOR / SOR Item filled in respective Tabs 

HSN/SAC Yes Auto populated HSN/Sac 

code from work details 

 

 

Quote (%) 

yes Auto populated Quoted 

Percentage as per tender 

award details 

Numerical value in 

percentage 

Schedule Name yes Schedule of the item, to be 

selected from drop down 

list 

Select schedule name of 

Item code yes User Enterable field for 

Item code of non-SOR item 

Applicable for only Non-

SOR item tab 

Item 

description 

yes User Enterable field for 

short description about of 

non-SOR item 

Applicable for only Non-

SOR item tab 

Item Yes Selectable option from 

drop-down list of SOR 

Items 

Select one SOR Item 

Unit Yes Select Measurement Unit 

of an item from drop-

down list 

Select one unit of 

measurement according to 

Non-SOR / SOR item 
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Rate Yes Enter Rate of an item Item rate in decimal 

Number rounded with 2 

decimal digits 

Quantity Yes Enter quantity of item Quantity in number, 

rounded with 3decimal 

digits 

Amount (INR) Yes Auto populated values 

based on calculation 

Amount = Rate*Quantity 

Amount in number with 2 

decimal points 

Remark No User enterable field with 

short description as 

remark 

 

Actions  

Add  + 

No Clickable icon to add more 

extra items click on + 

Clickable icon 

Delete No Clickable icon to delete an 

extra item from 

supplement item list of the 

amendment 

Clickable icon 
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4.1.3.3. Awarding for EPC works 

For EPC Works instead of BoQ, Schedule-H Items need to added follows, Go to WMS->Work-

>Tender Details-> View Tab click on Edit and go to Awarding Tab 

Click on + icon under Upload Schedule-H Column, define number Levels required for 

Schedule-H Items, Add each Items by level by level 

 

Figure 4.50 Schedule -H for EPC Type of Tender 

Add Item by following procedure for EPC kind of tender awarded  

• Select Level – Number of levels required to fill Items / Node details, if Item saved in 

Level 1 then unable to change the level as per Figure 4.1.3.3.3 

• Each Item, Node of EPC work could be added level by level as shown in Figure 

4.1.3.3.4  

• For Each level after Level-1 select an Item / Node which added in previous level 

• Fill the Item code, Item Description, Percentage, Unit, Quantity, Rate in each level 

• If Node having any sub-node, then that sub-node to be filled in the next level, Parent 

Node details filled with only Item code and Item Description 

• Amount will be calculated as per Unit, Quantity & Rate 
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Figure 4.51 Number of levels required for Schedule-H 

 

Figure 4.52 Level-1 data for Schedule-H 

 

Figure 4.53 Filling Data for Schedule-H 
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Field Description: 

Field Name Mandatory Description Validation 

Level Yes Select the level of the 

schedule-H item / node 

details to be filled 

 Select the appropriate 

level based on Schedule-H 

for Work to fill the Item/ 

Node details 

If Level1 – Items 

percentage is must be 

100% 

If Level 2 – Item with 

description only 

If Level3 – Node values 

with Percentage, Unit & 

Quantity to get Rate. In 

Level 3 if any node has sub 

node, then do not fill the 

percentage, unit, Quantity 

Item Code Yes Unique Item code to identify 

the item / the node in level 

Unique item code for item, 

in Alphanumeric 

Characters 

Item 

Description 

yes User Enterable field, to 

describe short description 

Description in Alphabets 

maximum of 100 

characters 

Percentage Conditionally 

Mandatory 

If Item described in 

Percentage, then value of 

percent to be filled 

Value of percentage 0-100 

with decimal point. Sum of 

percentage of each item in 

that level should be 100% 
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Unit Conditionally 

Mandatory 

Unit of measurement of an 

item/node based on level 

selected 

Select one unit of 

measurement from drop-

down list 

Quantity Conditionally 

Mandatory 

User Enterable field, for node 

then Quantity entered in 

number,  

If node is appliable for 

level enter the value for 

quantity as number 

rounded to 3 digits of 

decimal point 

Rate Yes Rate of an item / node would 

be auto populated 

 

Amount - Auto populated based on 

either percentage or Rate & 

Quantity 

Amount should cross the 

value for the level 

Delete - To Delete an item from the 

level by clicking Trash icon 

Item / Node to be deleted 

from appropriate level 

Save All Yes To save details about 

item/node entered in the 

selected level 

 

Edit - To edit item details To edit item details in the 

current level  

Update Conditionally 

Mandatory 

If Any Item / Node details are 

edited by user, then click 

update button to save the 

changes 

Must be clicked to save 

changes after editing  
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4.1.3.4. Reports & Exports 
Work Details compiled report is available at WMS -> Work Details -> View section. Click on 

Final Approval button of a work to get PDF format report for Work Details. 

 

Figure 4.54 Work Details Report 

 

 

Figure 4.55 Work Details Report (1) 
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Figure 4.56 Work Details Report (2) 

 

Figure 4.57 Work Details Report (3) 
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Figure 4.58 Work Details Report (4) 
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Figure 4.59 Work Details Report (5) 

 

 

 

4.2. 
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e-MB 

The e-MB module makes the measurement process for public works department digital, 

accurate, and more transparent. It enables authorized users—Recorder, Verifier, and 

Approver to efficiently track and manage work-related measurements 

Step-by-step instructions with Screenshots 

The module comprises two core functions: 

1. MB Issue – Allocation of MB books to designated officers for recording purposes. 

2. MB Recording – Capturing and managing work measurements with system validations 

and approvals. 

Note :  

⚫ Currently in Tamil Nadu, the Section Officer (AE) acts as the Recorder, the Sub-Divisional 

Officer (AEE) serves as the Verifier, and the Divisional Officer (EE) functions as the Ap-

prover. 

⚫ The Divisional Officer is responsible for issuing the e-MB to officers of the respective of-

fices. 

4.2.1. MB Issue 

Navigate to, e-MB --> Master --> Allocation (Figure 4.2.1), Allocation screen is displayed as 

shown in Figure 4.2.2. 

 

Figure 4.2.1: MB Allocation Navigation 

 

Figure 4.2.2 Allocation 
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After selection of Work from the drop down, MB Allocation details like MB Book Number, MB 

Issue Date and Allocation details details are displayed on screen as shown in Figure 4.2.3. 

 

Figure 4.2.3: Add Allocation 

Users can select the 'Is Multiple MB' checkbox when allocating multiple Measurement Books 

(MB's) for a single work. This is applicable in the following scenarios: 

Scenario 1: Allocation of MBs to multiple Sections within the same Sub-Divisions  

Scenario 2: Allocation of MBs to multiple Sections and multiple Sub-Divisions 

within the same Division. 

Scenario 3: Allocation of MBs to multiple Sections, multiple Sub-Divisions 

and multiple Divisions 

To issue a Measurement Book, the user must enter the MB Book Number (i.e., the actual 

physical measurement book number), MB Issue Date, and allocation details including 

approval level, designation, office, and user information. 

 

Upon clicking Save, a confirmation alert (as shown in Figure 4.2.4) will appear. Click OK to 

proceed. The system will then generate an eMB Number in the format: 

divCode/uniqueParentWorkID/splitWorkID/1 (where '1' is an incremental value) and save 

the MB allocation successfully. 
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Figure 4.2.4 :  eMB Allocation Save Confirmation Alert 

In case of multiple physical MB books available with section officers those MB book numbers 

can be entered as comma separated under the MB book number field as illustrated in Figure 

4.2.5 

 

Figure 4.2.5 : multiple  eMB entry 

Multiple MB:  

The Multiple MB functionality allows users to allocate measurements across multiple 

Sections, Sub-Divisions, and Divisions within a single MB issuance process 
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To issue multiple Measurement Books (MB), select the ‘Is Multiple MB’ checkbox. Upon 

selection, the Add More button is enabled, allowing the user to add multiple allocation entries, 

as illustrated in Figure 4.1.3. 

Scenario 1: Allocation of MB's to multiple Sections within the same Sub-Divisions    

To allocate multiple MB’s across multiple Sections within the same Sub-Divisions, the user 

must enter the respective MB Record Number and MB Issue Date for each allocation. The 

relevant Sections and their corresponding Sub-Divisions should then be selected accordingly, 

as illustrated in Figure 4.2.6 

 

Figure 4.2.6 : MB Allocation to different Sections and same Sub-Divisions  

Scenario 2: Allocation of MB's to multiple Sections and multiple Sub-Divisions within 

the same Division  

To allocate multiple MB's under the multiple Section and multiple Sub-Divisions within the 

same Division, the user must enter the MB Record Number and MB Issue Date for each 

allocation. The appropriate section and corresponding Sub-Divisions should then be selected, 

as illustrated in Figure 4.2.7. 
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Figure 4.2.7 : MB Allocation to same Section and across different Sub-Divisions 

Scenario 3: Allocation of MB's to multiple Sections, multiple Sub-Divisions, and 

multiple Divisions 

To allocate MB's across multiple Sections, Sub-Divisions, and Divisions, the user must enter 

the MB Record Number and MB Issue Date for each allocation. The relevant Section, Sub-

Division, and Division must then be selected accordingly. 

 

To edit the MB issue details, navigate to the View tab and select the relevant Work. Once 

selected, all associated allocation details will be displayed on the screen, along with the 

Update and Reallocation options.  

Click the Update button to modify the MB issue details, as illustrated in Figure 4.2.8. 

The user can reallocate issue details by modifying the Office and User for the flow of e-MB for 

any given work. 
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Figure 4.2.8 : Update Issue e-MB and Reallocation 

Field Description: 

Field Name Mandatory Description Validation 

Contract/Agreement Yes Select the appropriate 

contract/agreement from the 

drop down. 

Must be 

selected 

before saving. 

eMB Number Yes It is auto generated after saving 

allocation details.  

Format : 

divcode/uniqueParentworkID/sp

litworkID/incremental value 

starting from 1 

Automatically 

generated by 

the system  

and non-

editable 

Has the quantity 

been previously 

executed? 

No This is optional field. 

If this option is selected while 

issuing the MB, the Recorder will 

be able to enter consolidated 

item-wise executed 

measurements up to the current 

date before recording detailed 

measurements in the WAMIS 

application for ongoing work 

based on users choice. 

-- 

Is Multiple MB? No This is optional field. 

If this option is selected, Multiple 

MB functionality allows users to 

-- 
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allocate measurements across 

multiple Sections, Sub-Divisions, 

and Divisions within a single MB 

issuance process 

 

MB Book Number  Yes Enter MB book number.  

MB book numbers can be entered 

as comma separated if multiple 

physical MB’s issued to same 

section office 

Must be a 

alphanumeric 

value. 

MB Issue Date Yes Select MB issue date Allows 

selection up 

to the current 

date 

Approval Level Yes Select the appropriate Approval 

level 

Must be 

selected 

before saving. 

Designation Yes Select the appropriate 

Designation 

Must be 

selected 

before saving. 

Office Yes Select the appropriate Office Must be 

selected 

before saving. 

User Yes Select the appropriate User Must be 

selected 

before saving. 

Save -- On click Saves the allocation 

details 

-- 

 

 

4.2.2. MB Recording  

The MB Recording process follows a three-level workflow: Recording, Verification, and 

Approval.  

The Recorder enters the MB details, the Verifier reviews and confirms them, and the 

Approver gives the final approval 
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Navigate to,  e-MB --> Record And Inspection --> Measurement (Figure 4.2.9) 

 

Figure 4.2.9 : Measurement Nevigation 

Measurement screen is displayed as shown in Figure 4.2.10.  

 

Figure 4.2.10 : Measurement Work Selection 

Select the relevant Work. Once selected, all associated measurement and BoQ details will be 

displayed on the screen, along with the Photo Upload and View, Record Measurement, BoQ 

Items, Download Measurement Book, Download Excel and Upload Excel options as illustrated 

in Figure 4.2.11 

 

Figure 4.2.11 Record Measurement  

Photo Upload and View: In this section, the user can upload photos of the actual site 

measurement progress as shown in Figure 4.2.12. 
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Figure 4.2.12 Photo Upload 

Field Description: 

 

Field Name Mandatory Description Validation 

Upload Image Yes Select the image file to 

upload 

Image formats include .jpg, .jpeg, 

and .png, with a maximum file size 

of 2MB per image 

 

Uploaded images can be viewed from View tab as illustrated in Figure 4.2.13 

 

Figure 4.2.13:  Photo View 

Add Previously Executed Quantity:- 

If the ‘Has the quantity been previously executed?’ option is selected while issuing the MB, 

the user will be provided with an option to enter consolidated item-wise quantities, as shown 

in Figure 4.2.14. 

After entering the details,, the details should be finalized and sent for verification to the 

verifier. 
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Figure 4.2.14:  Add Previously Executed Quantity 

 

Add Measurement: Click the Record Measurement button to record the measurement details, 

as illustrated in Figure 4.2.15. 

⚫ User needs to select Date, enter Measurement For, Number, Typical Formula, Length, 

Breadth, Height/Depth details.  

⚫ Quantity is auto-calculated as per the entered Number, Typical Formula, Length, Breadth, 

Height/Depth details 

⚫ UOM and Rate (INR) details are auto displayed as per entered BoQ details 

⚫ Amount (INR) is auto calculated from Quantity and Rate (INR)  

⚫ Hidden Box provided in screen if any measurement is marked as hidden. 

Add More will add new Row for measurement details and Save All will save all the added 

measurement details 

Negative Measurements: Negative measurements against an item are recorded in the 

measurement book to reduce the executed quantity. 

Negative measurements are recorded in the MB using a negative (-) sign in typical 

measurements, as well as in the fields of number, length, breadth, and depth 

Quantity is auto calculated with negative value. The Total Quantity of the item should not be 

Zero (0) or less than Zero. 
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Figure 4.2.15:  Add Measurement  

For the Number, Typical Formula, Length, Breadth and Height fields Formulas are displayed 

as shown in Figure 4.2.16 

 

Figure 4.2.16 :  Formula displayed for Measurement  

Field Description: 

Field Name Mandatory Description Validation 

Date Yes Select the appropriate 

date for measurement 

Mandatory – Must be 

selected before saving. 

Measurement 

For 

Yes Enter measurement for 

details. 

Accept alphanumeric data 
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Number No Enter number details or 

select formula 

In the case of a formula, 

the user must enter the 

value of the variable. 

-- 

Typical 

Formula 

No Enter formula or select 

typical formula 

In the case of a formula, 

the user must enter the 

value of the variable. 

-- 

Length No Enter Length or select 

formula 

In the case of a formula, 

the user must enter the 

value of the variable. 

-- 

Breadth No Enter Breadth or select 

formula 

In the case of a formula, 

the user must enter the 

value of the variable. 

-- 

Height/Depth No 

 

Enter height/depth or 

select formula 

In the case of a formula, 

the user must enter the 

value of the variable. 

-- 

Is Hidden? No User can mark the 

measurement as hidden 

-- 

Quantity No Quantity is auto-

calculated as per the 

entered Number, Typical 

Formula, Length, Breadth, 

Height/Depth details 

-- 

UOM (Unit of 

Measurement) 

Yes It is auto-displayed -- 
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Rate(INR) Yes It is auto-displayed -- 

Amount(INR) Yes It is auto-displayed Auto calculated by the 

system 

 

Users can add measurement details by uploading the measurement Excel template, which is 

available for download from the Reorder login  

Download the Excel template for measurement as shown in Figure 4.2.17  

The user is required to enter the following details in the Excel template: Item Code, 

Description, Date, Measurement For, Number, Typical Formula, Length, Breadth, 

Height/Depth, Rate, Quantity, Amount, Unit of Measurement (UOM), Pending Quantity, and 

Executed Quantity. 

 

Figure 4.2.17: Measurement Excel Template  

Navigate to the View tab under Record Measurement to access saved measurement details. 

For each measurement entry, options such as Edit, Delete, Submit for Finalization, Comments, 

Audit Trail, and Attachments are available, as illustrated in Figure 4.2.18. 

 

Figure 4.2.18 :  View Measurement  

Click the Edit icon to modify the measurement details. 

Click the Delete icon to remove the measurement entry. 
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Note: Once the Recorder submits the measurement details for verification, the Edit and Delete 

options are disabled. 

Measurement Remark is displayed on click of Comments icon as showing in Figure 4.2.19  

 

Figure 4.2.19 : Measurement Comments 

Audits  

This section displays the complete audit history of recorded measurements, including details 

such as User Name, Employee Name, Designation, Remarks, and Timestamp as shown in 

Figure 4.2.20.  

It ensures traceability and accountability of all actions performed on measurement entries. 

 

Figure 4.2.20: Measurement Audit 

Attachment  

Users can upload relevant supporting documents for each measurement entry. To upload a 

document, select the desired file as shown in Figure 4.2.21. 

Once uploaded, details such as File Name, Upload Date, and the Delete option will be 

displayed on the screen. 

 

Figure 4.2.21: Measurement Attachment 
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Field Description : 

 

Field Name Mandatory Description Validation 

Choose File Yes Select the image file 

to upload 

Image formats include .pdf, .jpg, 

.jpeg, .png, .xls  . 

A maximum of 5 documents per 

measurement, with each file up-to  2 

MB in size is allowed.. 

 

Once all measurement details have been entered, click the “Send for Approval” button to 

forward the entries to the Verifier for verification along with remarks. 

 

Figure 4.2.22 : Measurement Send for Approval 

 

Figure 4.2.23 : Measurement Remark for Approval 
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4.2.3. MB Verification 

Once the measurement is recorded and submitted by the Recorder, it becomes available to 

the Verifier for verification.  

Navigate to,  e-MB --> Record and Inspection--> Verification (Figure 4.2.24 ),  Allocation 

screen is displayed as shown in Figure 4.2.25. 

 

Figure 4.2.24 : Measurement Nevigation - Verifier 

Measurement screen is displayed as shown in Figure 4.2.25.  

 

Figure 4.2.25 : Measurement Work Selection 

Select the relevant Work. Once selected, all associated measurement details including  

Records for Finalize, Finalized/Verified Records, Record Sent for Modification will be 

displayed on the screen, along with the Download Measurement Book option as illustrated in 

Figure 4.2.26 

⚫ Records for Finalize : All records that have not yet been finalized appear in this sec-

tion. 

⚫ Finalized/Verified Records :  This section shows the Finalized or Verified records 

⚫ Record Sent for Modification : This section shows the records which are available 

for modification 
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Figure 4.2.26 : Record Measurement  

Records for Finalize sections shows all the records which are available for finalize as 

illustrated in Figure 4.2.27 

 
Figure 4.2.27 : Record For Finalize Measurement 

 

To apply a common Checked Date to all measurement records, select the desired date in the 

Checked Date (Common) field and click the Add to All button, as shown in Figure 4.2.28. 

Alternatively, users can manually set the Checked Date for each individual measurement 

record as needed. 
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Figure 4.2.28 : Record For Checked Date 

At the Verifier level, for each measurement Edit, Remark, Audit, and Attachment options are 

available. 

Edit: Allows the Verifier to update the recorded measurement details. 

Remark: Displays the remarks entered during the measurement process. 

Audit: Provides a complete audit trail of the measurement, including User Name, Employee 

Name, Designation, Remarks, and Timestamp, ensuring transparency and accountability. 

Attachment: Shows the list of uploaded files associated with the measurement, including File 

Name and Upload Date. 

 

Figure 4.2.29 : Record For Finalize Measurement 
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Note : While Approving the measurement check is applied that User needs to mark at least 

10% of measurements as checked before proceeding. 

Click the Approve icon   to open the confirmation screen with two options: Send 

Back or Approve. 

Send Back: Returns the measurement details to the Reorder level for necessary corrections, 

along with mandatory remarks. 

Approve: Forwards the measurement details to the Approver level for further processing, 

accompanied by the provided remarks. 

 
Figure 4.2.30: Send Back or Finalize Measurement 

 

 

Figure 4.2.31 : Finalize Measurement 
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After the measurements are finalized at the Verifier  level, all finalized records are displayed 

under the Finalized/Verified Records section. 

 

Figure 4.2.32 : Finalized/Verified Records 

After the measurements are send back from Verifier level, all records are displayed under the 

Records Sent for Modification section as illustrated in Figure 4.2.33 

 

 

Figure 4.2.33 : Sent for Modification 

4.2.4. MB Approval  

Once the measurement is Verified by the Verifier, it becomes available to the Approver login 

for approval.  

Navigate to, e-MB --> Record and Inspection--> Verification (Figure 4.2.34), Allocation 

screen is displayed as shown in Figure 4.2.34. 

 

Figure 4.2.34 : Measurement Navigation - Approver 

Measurement screen is displayed as shown in Figure 4.2.35 
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Figure 4.2.35 : Measurement Work Selection 

Select the relevant Work. Once selected, all associated measurement details including  

Records for Finalize, Finalized/Verified Records, Record Sent for Modification will be 

displayed on the screen, along with the Download Measurement Book option as illustrated in 

Figure 4.2.36 

 

Figure 4.2.36 : Record Measurement  

Records for Finalize sections shows all the records which are available for finalize as 

illustrated in Figure 4.2.37 

 

Figure 4.2.37 : Record For Finalize Measurement 
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To apply a common Checked Date to all measurement records, select the desired date in the 

Checked Date (Common) field and click the Add to All button, as shown in Figure 4.2.38. 

Alternatively, users can manually set the Checked Date for each individual measurement 

record as needed. 

 

Figure 4.2.38 : Record For Checked Date 

At the Approver level, the following options are available for each measurement record: Edit, 

Remark, Audit and Attachment. 

Edit: Allows the Approver to update the recorded measurement details. 

Remark: Displays the remarks entered during the measurement process. 

Audit: Provides a complete audit trail of the measurement, including User Name, Employee 

Name, Designation, Remarks, and Timestamp, ensuring transparency and accountability. 

Attachment: Shows the list of uploaded files associated with the measurement, including File 

Name and Upload Date. 
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Figure 4.2.39 : Record For Finalize Measurement 

Note : While Approving the measurement check is applied that User needs to mark at least 

10% of measurements as checked before proceeding.. 

Click the Approve icon  to open the confirmation screen with two options: Send Back 

or Approve. 

Send Back: Returns the measurement details to the Verifier level for necessary corrections, 

along with mandatory remarks. 

Approve: Measurement details are approved by Approver level accompanied by the provided 

remarks. 

 

Figure 4.2.40 : Send Back or Finalize Measurement 

 



Works and Accounts Management Information System, User Manual  

     

98 
 

 

Figure 4.2.41 : Finalize Measurement 

After the measurements are finalized at the Approver level, all finalized records are displayed 

under the Finalized/Verified Records section. 

 

Figure 4.2.42  : Finalized/Verified Records 

 

Handling Multiple e-MB's Across Division, Sub-Divisions and Sections 

Scenario 1: Allocation of MB's to multiple Sections within the same Sub-Divisions 

The system supports the creation of multiple MB's under the same Division, including across 

multiple Sections within the same Sub-Divisions. 

When multiple sections operate within the same Sub-Division, each Section officer can 

independently generate and submit MB's for their assigned measurements. 

Each  MB is uniquely identified by its MB Book Number and follows a predefined approval 

workflow: 

Recorder → Verifier→ Approver . 

In case of multiple sections, section 1 will Record and Approve the  the measurement details 

as illustrated in Figure 4.2.43 
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Figure 4.2.43 : Measurement by Section 1 

Section 2 will Record and Approve the  measurement details as illustrated in Figure 4.2.44 

 

Figure 4.2.44 : Measurement by Section 2 

Consolidated measurement details from section1 and section2 will be available to sub-

division level as illustrated in Figure 4.2.45 
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Figure 4.2.45 : Consolidated Measurement at Sub-division 

Scenario 2: Allocation of MBs to multiple Sections and multiple Sub-Divisions within the 

same Division. 

In scenarios where sections operate under different Sub-Divisions, each section officer can 

similarly generate and submit MBs for their respective Verifier. 

The respective Verifier verifies these measurements, after which a consolidated summary is 

forwarded to the Approver for final approval. 

Scenario 3: Allocation of MBs to multiple Sections, multiple Sub-Divisions, and multiple 

Divisions  

In scenarios where different sections operate under different Sub-Divisions and different 

Divisions, each section officer can similarly generate and submit MBs for their respective 

Verifier. 

The respective Verifier verifies these measurements and forwards to the Approver for final 

approval.  

4.2.5. Reports & Exports 

Navigate to e-MB → Record and Inspection → Verification to access the available report 

options. 

Under Download Measurement Book, users can generate three types of reports: 

1. Measurement Book 
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2. Measurement Record Entry – Part I 

3. Measurement Record Entry – Part II 

 

Figure 4.2.46: Download Measurement Book 

 

1. Measurement Book Report : It shows the details of measurement books for each levels  

as illustrated in Figure  4.2.47  and Figure 4.2.48 

 

Figure 4.2.47 : Measurement Book 
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Figure 4.2.48  : Measurement Book 
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2. Measurement Record Entry – Part I Report: It shows the measurement details for each 

levels i.e AE, AEE and EE as illustrated in Figure 4.2.49 

 

Figure 4.2.49 : Measurement Record Entry Part I 
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3. Measurement Record Entry – Part II Report: It shows all the changes of actual meas-

urement for each level i.e AE, AEE and EE as illustrated in Figure 4.2.50 

 

Figure 4.2.50: Measurement Record Entry Part II 

4.3. e -Bill 

This module facilitates the billing process for construction and maintenance works 

while ensuring transparency. It allows a generation of contractor bills based on 

measurements included in the bill, which are verified and approved by the concerned 

officers. The system supports various types of bills, including: 

• Running Account (RA) Bills – periodic payments based on work progress, 

• Final Bills – raised upon project completion, and 

• First and Final Bills – used when the entire work is completed in a single 

phase, with no prior RA bills raised. 

The module includes two types of bills, each designed to handle different billing 

requirements effectively. 

1. Contractor Bill: A contract bill is a payment request submitted by a contractor 

for the work completed as per the work agreement. It is prepared based on the 

measured quantity of work and is approved by the concerned department 

before making the payment. This type of bill follows a six or seven level 

process with respect to the work category, ensuring proper verification and 

approval by multiple officers at each stage. 
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2. Hand Receipt Bill (HR): 

 A Hand Receipt Bill is used for making payments for various kind of expenditure 

for the work like Miscellaneous expenses.  

The WAMIS system supports the following types of Hand Receipts: 

i. PETTY EXPENSES 

ii. LABOUR WAGES 

iii. MACHINERY 

iv. OTHERS 

v. WORK 

vi. CONTINGENCIES 

vii. REFUND SD/DEFAULT WITHHELD - CLASS II DEPOSITS 

viii. BALANCE REFUND - CLASS III DEPOSIT 

ix. LABOUR WELFARE FUND 

x. MISCELLANEOUS PAYMENTS 

xi. FIRM/ADVERTISEMENT 

xii. REFUND OF REVENUE - REVENUE REFUND HEAD (1054) 
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Figure 4.60 Bill workflow 

1. Initiator (Section Officer) 

 The Initiator selects Item Details and Tax details to save the details then submits the 

bill to the next level Verifier for further processing. 

 

2. Verifier (Sub-divisional Officer) 

 The verifier scrutinizes the Item Details as per billed quantity with executed quantity 

provided by the initiator Upon confirmation; the verifier saves the information and 

submits the bill to the divisional level verifier. 

 

3. Verifier (Divisional Officer) 

 The Divisional Officer cross-checks the Item Details and Tax details provided by the 

initiator and Verifier then saves the entries and submits the bill to the next level for 

verification. 

 



Works and Accounts Management Information System, User Manual  

     

107 
 

4. Verifier (Divisional Officer-Auditor) 

 The Verifier audits the bill and calculates the applicable Taxes, Advances, Withheld 

and Recoveries for the bill and then forwards it to the next level accounts verifier. 

 

5. Verifier (Divisional Officer -Accounts) 

 The accounts officer verifies and, if necessary, modifies the Taxes, Advances, 

Withheld and Recoveries section before submitting the bill back to the Divisional 

officer. 

 

6. Approver (Divisional Officer) 

The Approver performs a final review of all entries and validations made by the Tax           

Verifier and Accounts officer. Once confirmed, the approver submits the bill for 

further     processing. 

Note:  

⚫ Currently in Tamil Nadu, for Contractor Bills & Hand Receipts, the Section Officer 

(AE) acts as the Bill Initiator, the Sub-Divisional Officer (AEE) serves as the 

Verifier, the Divisional Officers (AU/DAO) also serve as Verifiers, and the 

Divisional Engineer (DE) functions as the Approver. 

⚫ For EPC type of Tender works bill Initiator is Authority Engineer (AUE) assigned 

by Division Officer who configures the bill flow 

⚫ The ENC User (Divisional Master Admin) is allocating flow control for Hand 

Receipts (HR) types of bills to the respective officers under the division. 

4.3.1. e-Billing Process for Contractor Bill 

 e-Bill platforms typically incorporate role-based access controls to ensure that only 

authorized personnel such as Section officer, Sub divisional officer and Divisional officer can 

enter, edit, verify and approve billing records.     

To configure bill flow for each role, navigate to, e-Bill --> Configuration --> Flow Control as 

shown in (Figure 4.3.1.1), Flow Control screen is displayed as shown in Figure 4.3.1.2  

After getting window for 'Flow Control', click on the 'Add’ tab to get bill flow configuration 

screen will be displayed. On this screen, select the bill type from the Transaction Type drop-

down list. Then select respective Work numbers from the dropdown list 
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.  

 

 

 

 

Figure 4.3.1: Bill Flow configuration 

 

 

 

 

 

 

 

 

 

 

 

 Figure 4.3.2: Flow Control 

After selection of Transaction type from the drop down, the Bill allocation details like Work 

Number field and Allocation details table are displayed on screen as shown in Figure 4.3.3. 

Figure 4.61 Bill flow navigation 

Figure 4.62 Bill flow configuration by Divisional Officer 

Figure 4.63 Contractor Bill flow control configuration 
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Figure 4.64 Bill Allocation as per Role 

 Field Description: 

 Field 

Name 

Mandatory Description Validation 

Transaction 

Type 

Yes It is a user selectable drop-

down field, select 

Contractor / Hand Receipts 

Type 

Must be selected 

from the drop-down 

list. 

Work 

Number 

Yes 

 

It is a user selectable drop-

down field. If Work having 

any measurement, should 

be completed, those work 

numbers will be listed in 

options 

The user must select 

the specific work in 

the Work Number 

field to proceed with 

the bill flow 

allocation. 

Designation Yes 

 

Select the appropriate 

Designation from the drop 

down  

Must be selected 

before saving. 

Approval 

Level 

Yes Select the appropriate 

Approval level from the 

drop down 

Must be selected 

before saving. 
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Office Yes Select the appropriate 

Office from the drop down 

Must be selected 

before saving. 

User Yes Select the appropriate User Must be selected 

before saving. 

Save  

 

-- 

Click the save button and 

the Bill allocation gets 

saved. 

After saved the button 

changed into update 

Once the allocation 

is saved, it cannot be 

edited.  

      

Contractor e-bill Initiation  

The Bill initiator can start bill registration process after the allocation is completed by the 

Concern Authority from Divisional Office  . The bill will be initiated by the initiator login, and 

then it will proceed to the next level of authority for further processing. 

Navigate to, e-Bill --> Billing --> Bill Registration as shown in below figure 

 

Figure 4.3.4: Bill Registration 

   Bill Registration screen is displayed as shown in Figure 4.3.5.  

   

 

 

 

 

 

 

 

Figure 4.65 Bill Registration Navigation 
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Select the relevant Work Number. Once selected, all associated bill details and corresponding 

contract information will be displayed on the screen, as shown in Figure 4.3.1.5. 

 

Figure 4.66 Bill Registration for Work 

Field Description: 

Field Name Mandatory Description Validation 

Work Number Yes Select the appropriate Work 

Number from the drop-down. 

The user must select 

the related work. 

Contractor Name 

 

No It is auto populated It is populated 

according to the work 

number selected. 

Bill registration 

Number 

No It is auto generated -- 

Bill Type Yes It is a User selectable Drop 

down. RA Bill / Final Bill 

 

Select the bill type 

from the Drop-Down 

list. 

Supplier State Yes It is a User selectable Drop 

down. 

 

Select the Supplier 

state from the drop-

down list. 
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Supply State 

 

Yes It is auto populated It is populated 

according to the work 

number selected. For 

Tamil Nadu default as 

Tamil Nadu 

Invoice No Yes It is a User enterable field Enter the Invoice 

number of the 

Selected work. 

Invoice Date 

 

Yes It is a User enterable field Enter the Invoice Date 

of the Selected work. 

Bill Date Yes It is a User enterable field Bill date cannot be 

less than agreement 

date / last inspection 

date 

 

Head Yes It is an auto populated Heads will be 

populated according 

to the Work selected 

as per Heads mapped 

on the work will be 

displayed for 

selection. 

Sanction No. No It is a User enterable field Enter the valid 

Sanction No of the 

Work selected. 

RA Bill Number 

 

No It auto generated It is generated 

according to bill count 

for the work selected. 

Bill Description 

 

No User Enterable It is generated 

according to bill type 

for the work selected. 

Remarks No It is a User enterable field It allows a maximum 

of 500 characters to 

enter. 

Default Withheld On Yes It is a User selectable Drop Must select the 
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down. withheld for the work 

selected. 

Taxation (GST TDS, IT 

TDS & CESS) On 

Yes Select one option from the 

drop-down list to get applicable 

Tax values in that bill. Option 

one of the following  

 

• Base Work Value  

• Base Work - Withheld 

(Base Work Value) 

• Base Work - Withheld 

(Base Work Value + 

GST) 

 

Select one option of 

the following  

 

• Base Work 

Value (For EPC 

Works) 

• Base Work - 

Withheld 

(Base Work 

Value) 

• Base Work - 

Withheld 

(Base Work 

Value + GST) 

 

Is previous bill No Check box is provided Select the checkbox if 

the selected work has 

a previous bill. Bill 

details will be added 

for the previously 

executed bill. 

Save - Click the on the save button to 

save the bill master / header 

details 

-- 

Update No Click the update button to 

modify the Bill details. 

-- 

  

After the bill details are entered and successfully saved, multiple subsection tabs will appear 

below the Bill Registration screen.  These tabs are shown in Figure 4.3.6 
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Figure 4.67 Bill Sub Sections 

Field Description: 

 Name  Description  

Items Details   The user must select the relevant items that should be 

included in the bill. The selected items will be used to 

prepare and generate the bill. 

Tax Details  The user must select Yes /No options from dropdown list 

of "Is GST TDS Applicable" /"Is IT TDS Applicable"/ “Is 

CESS Applicable” dropdown list.   

By default, Is GST TDS Applicable is applicable to all bills 

as Yes. 

• If “Yes” is selected for IT TDS applicability, 

Income Tax will be deducted from the bill 

amount. 

• If “No” is selected, only GST will be applied, and 

no Income Tax deduction will occur. 

• If “YES” is selected Is CESS Applicable, cess rate 

would be deducted from the bill amount, by 

default showing rate as 1 % of Bill amount 

• If “NO” is selected Is CESS Applicable, cess is not 

deducted 

 

Advances  This section allows users to manage advances related to 

contractor bills by: 
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• Giving Advance – Issuing new advances 

(Mobilization, Material, or Secured) to support 

project needs. 

• Recovering Advance – Deducting previously 

issued advances from the current bill. 

In Tamil Nadu, common advance types include: 

• Mobilization Advance – For initial setup costs. 

• Material Advance – For procuring project 

materials. 

• Secured Advance – Against durable materials 

brought to site. 

The system ensures all advances are properly recorded 

and recovered, following departmental procedures and 

using familiar terms like Giving Advance and Recovering 

Advance. 

With-held amounts A withheld amount is the portion of a contractor’s bill 

that is deliberately retained by the department during bill 

processing, rather than making the full payment. This 

retention acts as a security measure to ensure 

compliance and completion of work. 

In Tamil Nadu, there are two types: 

• Default Withheld – System-defined deductions 

according to the works 

• Manual Withheld – User-defined based on 

specific needs 

Applicable percentage of Withheld Rates: 

• RA Bill: 5% retention 

• Final Bill: 2.5% retention 

• 6 % for EPC category of work 
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This section enables users to manage, and record 

withheld amounts across bill types. 

Recoveries The applicable deductions for the bill can be deducted It 

is divided into two main parts: Credited to Work and 

Recovery. 

Certificates Select the certificates submitted for the particular work    

Submit This section allows the user to do any one of the actions 

based on their role as per Bill flow allocation like Register 

/ Approve/ Verify/ Send back. Click the submit tab to 

submit the bill. 

 

All subsections require the user to input relevant information or perform specific actions as 

part of the complete E-Bill preparation and submission process. 

Within the available tabs under the Bill Registration screen, this is configurable depending on 

the user rights over screen, the following workflow is followed:                                      

Item Details: 

 Item Details displays all items available for billing, with the executed quantity shown as the billed 

quantity. Select the Item Details tab (see Figure 4.3.1.7), then check the boxes for the items you want 

to add to the bill. If any material coefficient is required for billing (see Figure 4.3.1.8), enter it, and then 

click the Save Items button to save the selected items. 

 

Figure 4.68 Item Details for Billing 
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Field Description: 

Field Name Mandatory Description Validation 

Select  Yes Click the checkbox 

to select an item for 

applicable billing  

Must be selected 

before saving, to 

select an item 

included for billing 

Item code  -- Auto populated 

from the BOQ 

-- 

Agreement Qty -- Auto populated 

from the BOQ 

-- 

Prev. Billed Qty -- It shows the up-to-

date quantity of the 

item executed up to 

the previous bill 

otherwise value 

shown as zero  

Auto populated 

value, cumulative 

sum of Previously 

billed quantity. 

Billed Qty -- Auto populated 

after approval of 

measurement book   

Auto populated 

value, sum of 

Previously billed 

quantity and value i 

quantity is equal to 

the quantity in 

measurement 

Item Rate -- Auto populated 

from the BOQ 

-- 

Item Amount -- Auto populated 

(Billed Qty * Rate) 

-- 

Material Coefficient No If Material 

coefficient 

applicable 

Click on Note icon  
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Save Item  yes On click Save item 

the item details get 

saved 

-- 

 

 

Figure 4.69 Material Coefficient 

Field Description: 

Field Name Mandatory Description Validation 

Material  Yes It is user selectable 

drop down 

Select the material 

from the drop-down 

list 

Co-efficient Yes It is a User enterable 

field 

Enter the Co-efficient 

between 0 to 20 

Conversion Factor  Yes Auto populated field Auto populated ac-

cording to the mate-

rial selected 

Actions         -  Click the edit icon to 

update the entered 

fields 

            - 

Save            -   Click the save button 

to save the entered 

fields 

              - 

Add            - Click the add button 

to add the new        

Material Co-efficient 

table.  

              - 
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Tax Details: 

 

Figure 4.70 Tax Details for Billing 

Tax details need to be filled in to deduct the applicable taxes from the bill amount. Click the 

Save Tax button to save the tax details, and then click the Submit tab to forward the details to 

the next-level verifying authority. If the “Is IT TDS Applicable and Is CESS Applicable” is select 

“yes” from the drop-down list. Then the screen below will be displayed. 

 

Figure 4.71 IT TDS & CESS details for bill 
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Field Description: 

Field Name Mandatory Description Validation 

Effective Date Yes It is user selectable and 

enterable filed 

      - 

Section Yes  It is auto populated form the 

payment master table  

 

IT TDS Rate  Yes It is user enterable filed Enter the percentage of 

TDS rate and only 2 

digits are allowed 

Cess Type Yes It is auto populated  

Cess Rate Yes It is user enterable filed Enter the cess   rate 

and only 2 digits are 

allowed 

Save tax        - Click the tax button to save the 

tax details of the work. 

 

 

Advances 

Click the Advances tab sections as shown in the figure 4.3.1.12, Here, advances related to 

this bill can be added by entering the required details on the table displayed. 

 

Figure 4.72 Advances 
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On click the add advances button, the below screen will be displayed.                                                                                                  

Then, save the Advances and submit the bill to the next-level Verifying Authority. 

Field Description: 

Field Name Mandatory Description Validation 

Advance Type Yes It is a user selectable single drop down Select the advance type 

from the drop down 

Amount Yes It is a User enterable field Enter the amount 

SAC code Yes It is a user selectable single drop down, 

Appropriate HSN/SAC to be selected 

Select the HSN/SAC code 

from the drop-down list. 

GST Amount Yes It is auto generated It is generated according 

to the HSN/SAC code 

selected. 

Narration No It is remark entered by user for 

reference 

This field is short 

description of the bill by 

user for references 

Edit  

 

No To Edit click on icon in actions  Click the edit icon to 

update the advances 

information  

Delete  

 

No To delete click on icon in actions Click the delete icon to 

delete the advances 

information 

Save  Yes Button Must be Clicked To save the changes 

Figure 4.73 Add Advances 
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With-held Amounts 

Click on the with-held amounts tab as shown in the figure 4.3.1.13. In Tamil Nadu, there are 

two types of Withheld Amounts: Default Withheld and Manual Withheld. Default 

withheld for RA bill is 5%, Final bill 2.5 % and for EPC type of Works is 6%. 

 

Figure 4.74 With-held amounts 

Field Description  

Field Name Mandatory Description Validation 

Withheld Type Yes User can select the 

withheld type 

according to the head 

mapped. 

Select one from 

the drop-down 

list 

Percent/Amount Yes Select the 

percentage/Amount 

for this bill 

Must enter the 

percentage/Am

ount 

Amount Yes Its user enterable filed Must enter the 

amount. 

Narration Yes Enter a brief 

explanation or context 

(up to 500 

characters). 

-- 
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Recoveries 

Click on the recoveries tab section as shown in the figure 4.3.1.14, This describes the 

various recoveries would be recovered from the bill amount 

 

Figure 4.75 Recoveries 

Field Description: 

 Credited To works 

Field Name Mandatory Description Validation 

Reason Yes It is user selectable 

drop down, based on 

reason recoveries 

deducted from the bill 

Select the reason 

from the drop-

down list 

Percentage /Amount Yes It is user selectable 

field either Rate or 

Amount 

Select one option 

either Percentage 

or Amount from 

the drop down 

Amount Yes It is user enterable 

field 

       - 

Save Yes - Users will be 

saving details 

2. Recovery 
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Recovery Type Yes It is user selectable 

drop down 

Select the Type 

from the drop-

down list 

Recovery Reason Yes It is user enterable 

field 

Enter the reason 

in the Field 

Percentage /Amount Yes It is user enterable 

field 

Select the 

percentage/Amo

unt from the drop 

down 

Deposit Recovery Yes It is user selectable 

field either Yes or No, 

If Yes- The recovery 

for Deposit work, 

otherwise select No 

One option must 

be selected from 

drop down list 

Amount Yes It is user enterable 

field 

Enter the amount 

to be recovered 

Save Yes - Users will be 

saving details 

 

Finally, submit the Tax details, Advances, withheld amounts and Recoveries subsection tabs 

to the next-level authority, the Accounts Officer, for verification. 

Once all the subsections are submitted by the Auditor, the bill becomes available in the 

Accounts Officer's login for further verification. 

Navigate to e-Bill → Billing → Bill Registration, following the same steps as described 

above. 

Then the accounts officer verifies those sub-section tabs and finally submitted them to final 

approval of the divisional officer. 
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Certificates Checklist:  

Certificate checklist listing which are certificates submitted for billing, select applicable 

certificate from the list by click on respective check box against the certificate and click on 

Save button. 

 

Figure 4.76 Certificate Checklist 

Field Name Mandatory Description Validation 

Sr.No Auto Generated 

Sequence 

Serial Number Optional 

selection 

Certificate Auto Populated 

Certificate List 

Auto Populated 

certificate list 

 

Select  Conditional Check box to select 

applicable certificates 

to be consider for 

billing 

 

                                                                                                      

Submit: 

Once complete all the tabs and clicks of the submit tab are shown in the figure 

4.3.1.17 

Here, clicks the register button the submission popup screen will be displayed as 

shown in the figure 4.3.1.18 
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Figure 4.77 Submission Screen 

Check the submission details and enter the remark, then click the submit button. 

On clicking the ‘Submit’ button, a confirmation popup will be displayed with ‘OK’ and 

‘Cancel’ options, as shown in Figure 4.3.1.18. 

                                                                                  

 

 

 

 

 

Field Description: 

Field Name Mandatory Description Validation 

Work Number Auto Generated 

Sequence 

Auto populated Work 

Number for that bill 

registered  

Optional selection 

Submitted To Yes Auto Populated user id , 

who will proceed the bill 

verification / approval 

 

Remark Yes Text field to have users 

remarks on each level of 

Bill verification and 

Approval 

Allow Alpha numeric 

characters, max of 

200 characters length 

Register  Yes To Register Bill 

information to next level 

of Officer as per Bill flow 

Click on Button  

Figure 4.3.1.18 Confirmation Screen 
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control configured 

Verify Yes This option is applicable 

to Bill Details Verifiers 

as per the flow control 

configuration. Based on 

the defined approval 

hierarchy, Verifiers can 

review the bill details 

and take the necessary 

actions such as approval, 

modification requests, or 

returning the bill to the 

previous level 

User should be 

configured as Verifier 

in flow control 

Send Back Optional If any modifications or 

updates are required in 

the bill details, the 

Verifier can send it back 

to the Bill Initiator or the 

previous level of Verifier 

in the flow control 

configuration 

Applicable while 

revert the bill to 

correct the billing 

information after 

verified by verifier as 

per flow control 

Approve Yes Final approval is 

required to submit the 

bill for payment 

processing. Approval 

rights are given to the 

Approver role in the 

flow control 

configuration 

Click Approve button, 

and type short 

description in the 

Approval 

confirmation prompt 

screen 
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Figure 4.79 Verified by each level of verification 

 

Figure 4.80 Approval for Bill 

Field Description: 

Field Name Mandatory Description Validation 

Work Number Auto Generated 

Sequence 

Auto populated Work 

Number for that bill 

registered  

Optional selection 

Submitted To Yes Auto Populated user id , 

who will proceed the bill 

verification / approval 

 

Remark Yes Text field to have users 

remarks on each level of 

Bill verification and 

Approval 

Allow Alpha numeric 

characters, max of 

200 characters length 

Submit Yes To Send Registered Bill 

information to next level 

of Officer as per Bill flow 

control configured 

Click on Button  
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Verify Yes This option is applicable 

to Bill Details Verifiers 

as per the flow control 

configuration. Based on 

the defined approval 

hierarchy, Verifiers can 

review the bill details 

and take the necessary 

actions such as approval, 

modification requests, or 

returning the bill to the 

previous level 

User should be 

configured as Verifier 

in flow control 

Send Back Optional If any modifications or 

updates are required in 

the bill details, the 

Verifier can send it back 

to the Bill Initiator or the 

previous level of Verifier 

in the flow control 

configuration 

Applicable while 

revert the bill to 

correct the billing 

information after 

verified by verifier as 

per flow control 

Approve Yes Final approval is 

required to submit the 

bill for payment 

processing. Approval 

rights are given to the 

Approver role in the 

flow control 

configuration 

Click Approve button, 

and type short 

description in the 

Approval 

confirmation prompt 

screen 
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Role-Based Module Access: 

User 

Role 

Role Description User Module Access Menus 

Item 

Details 

 

Tax 

Details 

 

Advances 

 

With-

held 

Amounts 

 

Recoveries 

 

Certificates 

 

Submit 

 

AE Initiator Select the 

necessary 

items 

 - - - - Select the 

necessary 

certificates 

Register 

Bill 

AEE Verifier Allows 

users to   

save 

updates 

- - - - Select the 

necessary 

certificates 

Submit 

or 

revert 

back 

AU Verifier  Allows 

users to   

save 

updates 

Allows 

users to   

save 

updates 

Allows 

users to   

save 

updates 

Allows 

users to   

save 

updates 

Select the 

necessary 

certificates 

Submit 

or 

revert 

back 

DAO Verifier  Allows 

users to   

save 

updates 

Allows 

users to   

save 

updates 

Allows 

users to   

save 

updates 

Allows 

users to   

save 

updates 

Select the 

necessary 

certificates 

Submit 

or 

revert 

back 

EE Verifier 

(Estimator)/Approver 

Allow 

users to   

save 

updates 

Allow 

users to   

save 

updates 

Allow 

users to   

save 

updates 

Allow 

users to   

save 

updates 

Allow users 

to   save 

updates 

Allow users 

to   save 

updates 

Allows 

users to 

submit 

and 

revert 

 

4.3.2. Reports & Exports 

Go to the view section, search the bill and click on the Bill Registration No. Bill registration 

screen will be displayed here click the submit section tab. User can see the generate All 

report button.  Click the button their User can see the four types of bills 

• Running Account Bill / First & Final Bill / Final Bill – Abstract summary of work. 

• Part I - Account of Work Executed 

• Part II - Certificate and Signature  
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• Part III - Memorandum of Payments  

 

Figure 4.81 Bill Report Generation 

RA Bill and Final Bill reports will be generated based on the type selected during bill 

registration by the Initiator.
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Bill Report 

RA BILL Report 

  

Figure 4.82 RA Bill 
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Part I Bill 

 

Figure 4.83 Part I Bill 

 

Figure 4.84 Part II Bill 
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Part III Bill 

 

Figure 4.85 Part III Bill 
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4.3.3. e-Billing Process for Hand Receipt Bill 

e-Bill platforms for Hand Receipts bill (HR) typically incorporate role-based access controls 

to ensure that only authorized personnel such as Section officer, Sub divisional officer and 

Divisional officer can enter, edit, verify and approve HR billing records.  

4.3.3.1. Hand Receipt Bill Flow Configuration 

To configure bill flow for Hand Receipt bills each role would be configured using Department 

Admin user login, navigate to, e-Bill --> Configuration --> Flow Control as shown in (Figure 

4.3.3.1.1), Flow Control screen is displayed as shown in Figure 4.3.3.1.2  

After getting window for 'Flow Control', click on the 'Add’ tab to get bill flow configuration 

screen will be displayed. On this screen, select the bill type from the Transaction Type drop-

down list.  

Then select respective Transaction Type for Hand Receipt bill would be processed from the 

dropdown list as shown in Figure 4.86 

To save HR bill flow control click on save button as shown in  Figure 4.87 select Designation 

and roles for Initiator(Sectional Officer), Verifier(Sub Divisional officer),Verifier (Divisional 

Officer), Verifier (Divisional Officer– Tax),Verifier (Divisional Officer-Accounts), Approver 

(Divisional Officer) 

 

Figure 4.3.3.1.1 Hand Receipt Bill flow configuration by Department master Admin user 
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Figure 4.3.3.1.2 Navigation Bill Flow Control 

 

Figure 4.3.3.1.3 Select Hand Receipts Transaction Type 
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Figure 4.3.3.1.4  Assign Deportment User & Roles for HR Bill 

Field Description: 

 Field 

Name 

Mandatory Description Validation 

Transaction 

Type 

Yes It is a user selectable drop-

down field, select Hand 

Receipts Transaction Type 

Must be selected 

from the drop-down 

list. 

Designation Yes 

 

Select the appropriate 

Designation from the drop 

down  

Must be selected 

before saving. 

Approval 

Level 

Yes Select the appropriate 

Approval level from the 

drop down 

Must be selected 

before saving. 

Save Yes To save flow control 

configuration for 

Transaction Type of HR bill 

Must be clicked to 

save 

Reset No To clear the selected value 

for drop down list for 

Transaction Type of HR bill 
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To view existing flow control, click on “View” tab and select Transaction Type from the 

drop-down list. 

If any change of flow control required click on Edit Button to change flow control 

designation and Approval level for HR bill as shown Figure 4.88 

After editing / change Designation & Approval role click on Update button to save changes 

Note: If Any HR Bill initiated and in-progress unable to edit the Bill flow control 

 

Figure 4.3.3.1.7 Edit HR Flow Control 

Field Description: 

 Field 

Name 

Mandatory Description Validation 

Transaction 

Type 

Yes It is a user selectable drop-

down field, select Hand 

Receipts Transaction Type 

Must be selected 

from the drop-down 

list. 

Designation Conditionally 

Mandatory 

only while 

Edit 

 

Select the appropriate 

Designation from the drop 

down  

Must be selected 

before update 

changes. 

Approval Conditionally Select the appropriate Must be selected 
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Level Mandatory 

only while 

edit 

 

Approval level from the 

drop down 

before update 

changes 

Edit Yes To save flow control 

configuration for 

Transaction Type of HR bill 

Must be clicked to 

save 

Delete No To delete the flow for drop 

down list for Transaction 

Type of HR bill 

 

 

4.3.3.2. Hand Receipt Bill Process 

The Bill initiator can start bill registration process after the allocation is completed by the 

Concern Authority from Divisional Office. The bill will be initiated by the initiator login, and 

then it will proceed to the next level of authority for further processing. 

Navigate to, e-Bill --> Billing --> Bill Registration as shown in below figure 

 

Select the Hand Receipts tab, select the transaction type from the drop-down list. 

Select the relevant Work Number. Once selected, all associated bill details and 

corresponding Hand Receipt Header information will be displayed on the screen, as shown 

in Figure 4.3.3.2.2. 

Figure 4.3.3.2.1 HR Bill Navigation Initiator 
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Figure 4.90 Hand Receipt Bill Header 

Field Description: 

Field Name Mandatory Description Validation 

Work Number Yes Select the appropriate Work 

Number from the drop-down. 

The user must select 

the related work. 

Payee 

 

Yes Select the appropriate Payee 

details from the list of payees in 

the drop-down 

One Payee must be 

selected from the drop 

down 

Bill registration 

Number 

No It is auto generated -- 

Supplier State Yes It is a User selectable Drop 

down. 

 

Select the Supplier 

state from the drop-

down list. 

Supply State 

 

Yes It is auto populated It is populated 

according to the work 

number selected. For 

Tamil Nadu default as 

Tamil Nadu 

Invoice No Yes It is a User enterable field Enter the Invoice 
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number of the 

Selected work. 

Invoice Date 

 

Yes It is a User enterable field Enter the Invoice Date 

of the Selected work. 

Remarks No It is a User enterable field It allows a maximum 

of 500 characters to 

enter. 

Save - Click the on the save button to 

save the bill master / header 

details 

-- 

Update No Click the update button to 

modify the Bill details. 

If once Initiator save 

the bill header then 

only Update button 

would be visible 

  

After the bill details are entered and successfully saved, multiple subsection tabs will appear 

below the Bill Registration screen shown in Figure 4.3.3.2.3 Items Details, Tax Details, 

Recoveries and Submit 

Field Description: 

 Name  Description  

Items Details   The user must select the relevant items that should be 

included in the bill. The selected items will be used to 

prepare and generate the bill. 

Tax Details  The user must select Yes /No options from dropdown list 

of "Is GST TDS Applicable" /"Is IT TDS Applicable” 

dropdown list.   

By default, Is GST TDS Applicable is applicable to all bills 

as Yes. 

• If “Yes” is selected for IT TDS applicability, 

Income Tax will be deducted from the bill 

amount. 
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• If “No” is selected, only GST will be applied, and 

no Income Tax deduction will occur. 

• If “YES” is selected Is CESS Applicable, cess rate 

would be deducted from the bill amount, by 

default showing rate as 1 % of Bill amount 

Recoveries The applicable deductions for the bill can be deducted It 

as recoveries for HR bill. 

Submit This section allows the user to do any one of the actions 

based on their role as per Bill flow allocation like Register 

/ Approve/ Verify/ Send back. Click the submit tab to 

submit the bill. 

 

 

Figure 4.91 HR Bills Items 

Item Details Field Description: 

Field Name Mandatory Description Validation 

Sr.No Yes Auto Generated 

Serial Number  

Must be selected before 

saving, to select an item 

included for billing 
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Item Code Name Yes User Enterable Field  Enter 

Good / Service Yes Selectable Option 

from dropdown list 

Must select one option 

either Good or Service 

HSN/SAC Yes Selectable option 

from drop down list, 

select the applicable 

HSN/Sac code from 

the list  

Must select one option 

from the drop-down list 

Quantity Yes User Enterable field 

for fill the quantity 

of Item as used for 

billing   

Enter the quantity in 

numerical value 

Rate yes User Enterable field, 

enter the rate of an 

item in numeric 

value 

Enter only Numeric 

value  

Amount -- Auto populated 

(Billed Qty * Rate) 

-- 

Save Yes Clickable button to 

save add item 

details 

Must be clicked once 

after adding the item 

Delete [  ] -- Clickable action icon 

to delete an item 

Clickable action icon to 

be clicked to delete an 

item 

Add Item [ +] Yes Clickable icon to add 

new item for the bill 

Must be clicked to add 

more item for HR Bill 
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Recoveries 

Click on the recoveries tab section as shown in the figure 4.3.3.2.4, This describes the various 

recoveries would be recovered from the HR bill amount 

 

Figure 4.92 Recoveries for Hand Receipt 

 

Figure 4.93 Recoveries for HR Bill 

Field Description: 

Field Name Mandatory Description Validation 

Recovery Type Yes It is user selectable 

drop down 

Select the Type 

from the drop-

down list 
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Recovery Reason Yes It is user enterable 

field 

Enter the reason 

in the Field 

Percentage /Amount Yes It is user selectable 

field 

Select the 

percentage/Amo

unt from the drop 

down 

Deposit Recovery Yes It is user selectable 

field either Yes or No, 

If Yes- The recovery 

for Deposit work, 

otherwise select No 

One option must 

be selected from 

drop down list 

Amount Yes It is user enterable 

field 

Enter the amount 

to be recovered 

Save Yes - Users will be 

saving details 

 

Tax Details: 

Tax details need to be filled in to deduct the applicable taxes from the bill amount. Click the 

Save Tax button to save the tax details, and then click the Submit tab to forward the details 

to the next-level verifying authority. Tax details for HR type of bills shown below 

 

Figure 4.94 HR Bill Tax Details 



Works and Accounts Management Information System, User Manual  

     

146 
 

 

 

Figure 4.95 HR Bill Tax Details 

Field Description: 

Field Name Mandatory Description Validation 

Is GST TDS Applicable Yes It is user selectable 

drop down 

Select either Yes 

or No from drop 

down list 

GST Tax Detail 

Sr.No  Auto generated Serial 

Number 

 

Rate %  Rate of % GST TDS 

applicable for Item/ 

Amount 

 

Item  Items added in Bill  

Total withheld 

Amount 

 Total Withheld 

Amount deducted as 

per configuration 

 

CGST%  Rate of % CGST  

CGST Amount  CGST in Amount  

SGST %  Rate % of SGST   

SGST Amount  SGST Amount   
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Is IT TDS Applicable Yes It is user selectable 

drop down 

Select either Yes 

or No from drop 

down list 

Income Tax Details 

Sr.No  Auto generated Serial 

Number 

 

Effective Date  Date of Tax applied  

Section  Section of Tax 

deduction applicable 

for Tax Deduction, 

auto selected based on 

configuration 

 

Section Sub type  Tax detection section 

sub type 

 

Bill limit Amount  Limit amount for 

Taxation 

 

IT TDS Rate %  Rate of Tax % 

applicable 

 

Income Tax Amount  Amount of tax to be 

deducted from bill 

amount  

 

 Save Yes - Users will be 

saving details 

 

Submit Bill for Verification: 

Hand Receipts bills register in while initiator click on Register Button. Bill will send to after 

submitted for next level of officer in flow control for approval. As shown in Figure 4.96 

Initiator have to click on Register Button in Submit Tab  
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Figure 4.97 HR Bill Registration 

For each level verification officer have to verifies the details of bill Items, Tax Details, 

Recoveries and finally submit it for next level approval click on Verify button 

 

Figure 4.98 HR Bill verification 

To Update bill information verifier can send back the bill to Previous level of Verifier / 

Initiator by click on Send Back button 

 

Figure 4.99 HR Bill Send back during verification 
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Field Description: 

Field Name Mandatory Description Validation 

Work Number Auto Generated 

Sequence 

Auto populated Work 

Number for that bill 

registered  

Optional selection 

Submitted To Yes Auto Populated user id , 

who will proceed the bill 

verification / approval 

 

Remark Yes Text field to have users 

remarks on each level of 

Bill verification and 

Approval 

Allow Alpha numeric 

characters, max of 

200 characters length 

Register  Yes To Register Bill 

information to next level 

of Officer as per Bill flow 

control configured 

Click on Button  

Verify Yes This option is applicable 

to Bill Details Verifiers 

as per the flow control 

configuration. Based on 

the defined approval 

hierarchy, Verifiers can 

review the bill details 

and take the necessary 

actions such as approval, 

modification requests, or 

returning the bill to the 

previous level 

User should be 

configured as Verifier 

in flow control 

Send Back Optional If any modifications or 

updates are required in 

the bill details, the 

Verifier can send it back 

to the Bill Initiator or the 

previous level of Verifier 

in the flow control 

configuration 

Applicable while 

revert the bill to 

correct the billing 

information after 

verified by verifier as 

per flow control 
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Approve Yes Final approval is 

required to submit the 

bill for payment 

processing. Approval 

rights are given to the 

Approver role in the 

flow control 

configuration 

Click Approve button, 

and type short 

description in the 

Approval 

confirmation prompt 

screen 

 
 
 
 

4.4. Department Masters 

Master Data refers to the core set of information that is essential for the consistent 

operation of processes within the system. It serves as the foundation for all transactional 

and operational activities across departments and modules. 

 

Access Control: 

Master Admin of the Division is the authorized personnel can view and create the 

Master Data to align their operations with defined parameters, ensuring system-wide 

consistency. 

WAMIS consists of the following Master Data entries: 

• Scheme-Defines the funding or administrative scheme under which the work is 

sanctioned. 

• User Department - The department whose work is being executed 

• Work Type - Categorizes the primary nature of the work (e.g., Building, Bridges, 

Roads, Water Resources). 

• Work Office – Specify Office classified into CSSA Office and User Office 

• Work Sub-Type - further classifies the work type into more specific categories. 

• Proposer Type - Indicates whether the proposer is new, revised, or 

supplemental. 

• Work Advance Type - Specifies the type of advance payment applicable to the 

work. 

• Payee -Identifies the individual or organization to whom payments will be made. 

• HSN/SAC -Denotes the tax code classification for goods (HSN) or services (SAC). 

• Unit of Measurement - Defines the measurement units (e.g., meters, tons) for 

work quantities. 
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4.4.1. Scheme 

 Login with the respective Department Master Admin account. 

Navigate to WMS → Masters → SCHEME. This opens the ‘SCHEME’ Master Screen, which is 

used to create and manage various schemes (see Figure 4.4.1.1). Once you click on SCHEME, 

the entry form will automatically appear. 

 

To add a new entry, select the Scheme option listed, choose a Sponsor Name from the 

available options, and enter the Scheme Name. Then, click the ‘Save’ button (see Figure 

4.4.1.2). After saving, click on the View tab to approve the scheme created from the Add tab. 

 

 

 

 

 

 

 

Figure 4.100 Master Navigation to Scheme 

 

 

Figure 4.101 Add Scheme 



Works and Accounts Management Information System, User Manual  

     

152 
 

 

 

Figure 4.102 Scheme View Screen 

• To add new item, verify the details before approving it  

• To edit the details, click on the “pencil”  icon. 

• To save the modified values click on the “update” Button. 

• To cancel the entry or the modification click on the “cancel” icon. 

• To delete the entry, click on the “delete  icon”. 

• To approve the entry, click on the “tick mark  icon”. 

• To confirm the approval, check the details and click on Approve Button 

• To audit about scheme information which are users and action performed by 

them on Scheme data by click on tick mark  

 

Go to WMS -->Masters -->SCHEME-->SPONSOR, this screen displays the "SPONSOR" 

Master Screen, which is used to create and manage various sponsor for scheme. 
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Figure 4.103 Sponsor Add Screen 

Field Description: 

Field Name Mandatory Description Validation 

Sponsor Name Yes User Enterable text field to 

specify the name of the sponsor 

 

Save Yes Clickable button to save sponsor 

name  

Must be clicked 

after entering 

Sponsor name to 

save information 

Reset  No Clickable button to clear all 

input fields 
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To add a new entry for a sponsor, click on the Sponsor tab and then click on the Add tab. 

Enter the Sponsor Name and click the Save button to add the sponsor. Next, click on the  

View tab to approve the newly created sponsor. You can also approve, edit, delete, or cancel 

sponsor information by using the options available in the Action column of the View tab 

 

 

Figure 4.104 : Sponsor View Screen 

• To add new item, verify the details before approving it  

• To edit the details, click on the “pencil”  icon. 

• To save the modified values click on the “update” Button. 

• To cancel the entry or the modification click on the “cancel” icon. 

• To delete the entry, click on the “delete  icon”. 

• To approve the entry, click on the “tick mark  icon”. 

• To confirm the approval, check the details and click on Approve Button 

• To auditing which are users and action performed on Sponsor data click the 

tick mark  

 

4.4.2. User Department 

Go to WMS → Masters → User Department (see Figure 4.4.2.1). Select the Add tab, then 

enter the Department Name, Department Number, and Department Code, and click on 

Save. 

On the View page, users can see the list of departments, approve them, and search for 

departments by name or number using the search option available in the View tab. 
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Figure 4.105 User Department Add Screen 

 

Field Description: 

Field Name Mandatory Description Validation 

Department 

Name 

Yes User-enterable text 

field to specify the 

department name. 

Which would be 

displayed as User 

Department in 

Deposit category of 

works 

Cannot be blank; max 

character limit is 50 Chars 

 Only letters (A-Z), spaces, 

periods (.), hyphens (-), 

ampersands (&) and 

parentheses (()) 

Demand 

Number 

Yes User-enterable field 

for the department's 

demand number. 

Cannot be blank; 

alphanumeric; special 

characters allowed as per 

format. Max Length is 4 

Characters 

Department 

Code 

Yes Alphanumeric field 

for department code 

(e.g., "D123", "A45B"). 

Must contain letters and/or 

numbers; max length (e.g., 

10 chars); no spaces. 

Save Yes Clickable button, to 

save User Department 

details 

Enabled & Clicked after 

enter required input fields 
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Click on view tab, to edit / delete /approve user department saved in Add tab as shown in 

Figure 4.4.2.2. Following step describe various action could be performed on saved user 

department details. 

• To add new item, verify the details before approving it  

• To edit the details, click on the “pencil”  icon. 

• Then update / Modify required changes, to save the modified values click on 

the “Modify” Button. 

• To cancel the entry or the modification click on the “cancel” icon. 

• To delete the entry, click on the “delete  icon”. 

• To approve the entry, click on the “tick mark  icon”. 

• To confirm the approval, check the details and click on Approve Button 

• To view which are users and action performed by user-on-User Department 

data click on tick mark  

 

 

 

 

Figure 4.4.2.2 View and Approve User Department 
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Field Description: 

Field Name Mandatory Description Validation 

Department 

Name 

Yes Describe the user 

departments for 

Deposit category of 

work, which is auto 

populated from 

already saved data 

Auto populated from after 

save in Add User 

Department, cannot be 

blank; max character limit is 

50 Chars 

 Only letters (A-Z), spaces, 

periods (.), hyphens (-), 

ampersands (&) and 

parentheses (()) 

Demand 

Number 

Yes Auto populated data 

field for the 

department's demand 

number, from already 

saved data. 

Auto Populated, cannot be 

blank; alphanumeric; special 

characters allowed as per 

format. Max Length is 4 

Characters 

Department 

Code 

Yes Alphanumeric field 

for department code 

(e.g., "D123", "A45B"). 

Must contain letters and/or 

numbers; max length (e.g., 

10 chars); no spaces. 

Status Yes Status field have one 

of the following 

REGISTERED/MODIFI

ED/REJECTED/APPR

OVED /CANCELD, 

based on action 

performed on data by 

Admin user 

 

Status value gets updated as 

per Action performed on 

saved data. Initial value is 

REGISTERED, if User 

department should be 

Approved for display while 

creating Deposit Works 

 

4.4.3. Work Types 

Go to WMS → Masters → Work Types. This screen displays the Work Types master 

screen, which is used to create various work types. Click on Add, enter the necessary 

details, and then click Save. 
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Figure 4.107 Work Types List view screen 

 

Field Description: 

Field 

Name 

Mandatory Description Validation 

Type Yes User-enterable text field 

to specify the type. To 

describe the type of work 

Alphanumeric; cannot be blank; 

max length (e.g., 100 chars). 

Work Type Yes User-enterable text field 

to define the nature of the 

work. 

Alphanumeric; cannot be blank; 

max 100 characters. Only 

Alphanumeric and. ()/_&:"- " 

characters only allowed 

Work Type 

Code 

Yes Numeric field 

representing the unique 

code for the work type. 

Must be numeric only; cannot be 

blank; no special characters 

allowed. Maximum length limit is 

15 characters 

Is 

Important 

Yes Yes/No field (radio 

button or dropdown) to 

mark criticality. 

Must select either "Yes" or "No"; 

default selection disabled. 

Work 

Category 

Yes Dropdown field to select 

category (e.g., Other, 

Contractor). 

Must select from predefined 

values; default must not be 

empty. 
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Save Yes Clickable button to save 

Work Type information 

Must be clicked after entering 

data for required input fields 

 

 

Figure 4.108 Work Types Entry Screen 

• To add new item, verify the details before approving it  

• To edit the work type details, click on the “”  icon. 

• To save the modified values click on the “Modify” Button. 

• To cancel the entry or the modification click on  icon . 

• To delete the entry, click on the “delete  icon”. 

• To approve the entry, click on the “tick mark  icon”. 

• To confirm the approval, check the details and click on Approve Button 

• To audit the users and the actions performed for adding a work type, click on 

the tick mark  

• Divisional Officers have the privilege to view records. 

• Department nodal has the privilege to view, add, approve and delete records.  

 

4.4.4. Work Sub Types 

Go to WMS -->Masters --> Work Subtypes, this screen displays the “Work Subtypes” 

Master screen. This screen is used to create the various sub type of work 



Works and Accounts Management Information System, User Manual  

     

160 
 

 

 

Figure 4.109 Work Subtypes Entry Screen 

Field Description: 

Field 

Name 

Mandatory Description Validation 

Type Yes User must select type 

from list of options 

shown. 

Cannot be blank; Select at least 

one option from the list 

Work 

Type 

Yes User must select type 

from list of options 

shown 

Cannot be blank; Select at least 

one option from the list 

Work Sub 

Type 

Yes Field to specify a more 

granular classification of 

the work type. 

Cannot be blank; 

alphanumeric; must match 

associated Work Type. 

Work Sub 

Type 

Code 

Yes Unique code for the work 

sub-type. 

Alphanumeric or numeric; 

must be unique; no special 

characters; max 10 chars. 

Save Yes Clickable button to save 

Work Type information 

Must be clicked after entering 

data for required input fields 
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Figure 4.110 View / Approve Work Sub Type 

 

• To View Work Sub Type Entries, click on View Tab. 

• To edit the details, click on the “pencil”  icon. 

• To save the modified values click on the “update” Button. 

• To cancel the entry or the modification click on “cancel”  icon. 

• To delete the entry, click on the “delete  icon”. 

• To approve the entry, click on the “tick mark  icon”. 

• To accept the entry, click on Approve Button 

• Divisional Officers have the privilege to delete, approve and cancel records. 

• To audit the users and the actions performed for adding a work sub-type, click 

on the tick mark  

 

4.4.5. Proposer Types 

Go to WMS-->MASTER --> PROPOSER Types, this screen displays the   Proposer Types” 

Master screen. This screen is used to create the various Proposer Types. 

Enter the Proposer Name and click on save as shown in figure 4.4.5.1, then click on View 

Tab to approve the newly added proposer details 
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Figure 4.111 Add Proposer Type 

 

 

Visit View tab and see the Proposer Name details which will be automatically once given 

save in the add tab. 

 

• To add new entry, click on the “Save” Button. 

• To View Proposer Type Entries, click on View Tab. 

• To edit the Proposer Type, click on the “pencil”  icon. 

• To save the modified values click on the “Modify” Button. 

• To cancel the entry or the modification click on the “cancel” icon. 

• To delete the entry, click on the “delete  icon”. 

• To approve the entry, click on the “tick mark  icon”. 

• To accept the entry, click on Approve Button 

• Divisional Officers have the privilege to, delete, approve and cancel records. 

• To audit the users and the actions performed for adding a proposer type, click on 

the tick mark 

 

Figure 4.4.5.2 View / Approve Proposer Type 
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4.4.6. Work Advance Type 

Go to WMS --> Masters --> Work Advance Type, this screen displays the “Work 

Advance Type” Master screen. This screen is used to create the various Work Advance 

Type. 

 

Enter the Work Advance Type and click Save. It will be reflected in the View tab and updated 

in the relevant forms, allowing users to select it from the drop down according to the master 

data. 

 

 

• To View Work Advance Type Entries, click on View Tab. 

• To edit Work Advances Type, click on the “Pencil” icon. 

• To cancel the entry or the modification click on the “cancel” icon. 

• To delete the entry, click on the “Trash  icon”. 

• To approve the entry, click on the “circled tick mark  icon”. 

• To accept the entry, click on Approve Button 

 

4.4.7. Payee 

Go to WMS --> Masters --> Payee this screen displays the “Payee” Master screen. This 

screen is used to create the various Payee Types. 

Figure 4.4.6.1 Work Advance Type List Entry Screen 



Works and Accounts Management Information System, User Manual  

     

164 
 

 

Figure 4.114 Payee type List Entry Screen 

To add GSTIN details of the Payee if applicable, then click on “Add GSTIN” button 

and fill the GST Type, Registration State, Effective from Date, Effective to Date 

and Registration Address kind of Information as shown in figure 4.4.7.2. 

 

 

Figure 4.115 Payee type List Entry Screen 
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Field Description: 

Field Name Mandatory Description Validation 

Payee No Auto 

generated 

Unique ID automatically 

generated by the 

WAMIS system. 

Read-only, system 

generated. 

Payee Type Yes Dropdown field to select 

the type of payee (e.g., 

Other, 

Company/Agency, 

Government Payee). 

Must select one from 

predefined values 

listed in the option. 

PAN Number Conditional 

(if Payee 

Type = 

Company/A

gency or 

Governmen

t Payee) 

User-enterable PAN 

number. 

10-character 

alphanumeric PAN 

format (e.g., 

ABCDE1234F); 

Validate the PAN 

number match with 

format XXXXX0000X. 

 

Name as per PAN Conditional 

(if Payee 

Type = 

Company/A

gency or 

Governmen

t Payee) 

Text field to enter the 

name exactly as per PAN 

card. 

Must match format; 

cannot be blank if PAN 

Number is provided. 

Payee Name Conditional 

(if Payee 

Type = 

Company/A

gency or 

Governmen

t Payee) 

User-enterable name of 

the payee. 

Alphanumeric; cannot 

be blank if Payee Type 

is selected. 
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Payee Code Conditional 

(if Payee 

Type = 

Company/A

gency or 

Governmen

t Payee) 

Numeric code assigned 

to the payee. 

Numeric only; required 

if Payee Type is 

selected. 

TAN Number Conditional 

(Yes if 

Payee Type 

requires 

TDS) 

Enter TAN if required by 

Payee Type (e.g., 

contractor/firms with 

TDS obligations). 

Must match TAN 

format (10-character 

alphanumeric, e.g., 

MUMA12345G). 

If GSTIN is applicable, then only below fields need to be filled for Payee after Clicking 

Add GSTIN button 

GST Type  Yes Select any one of the 

options listed 

“Composite, 

Unregistered, Regular” 

Must one option to be 

selected  

GSTIN  Yes Enter GSTIN 

Registration Number of 

the Payee 

 Alphanumeric 

Characters of at Most 

15 Characters only 

Registration State  Yes  Auto Filled based GSTIN 

Type 

Registration State 

Should be Displayed 

based on State code 

assigned for GSTIN 

Registration Address No Enter Full address of 

GSTIN Registered 

Enter Address Details 

within 80 Characters 

length 
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Effective From Date  No Select Date from 

Calendar to specify 

GSTIN Registration Date 

 Date  

Effective To Date No Select Date from 

Calendar to specify the 

GSTIN Expiration Date 

 Date  

Actions   +  Yes  To Add GSTIN Details  Click on + icon 

  
No To Delete GSTIN details  Click on delete Icon 

Save - Click Button to Save 

GSTIN details  

 

 

 

• To add a new entry, click on the “Save” Button. 

• To the edit details, click on the “pencil icon” Link. 

• To save the modified values click on the “update” Button. 

 

 

After clicking the Save button, the payee details will be saved and displayed in the View tab 

for approval. Click the View tab to see the newly added payee details from the Add screen. 

 

View Tab 

 

Figure 4.116 Payee View 
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Search for the payee details by entering any one of the displayed fields to retrieve the newly 

added payee information. Click the Approval button in the Actions column of the View table. 

The payee details will then be submitted to the ‘Map Existing Payee’ tab for mapping the 

newly added payee as shown in the Figure 4.4.7.4. Before Approving Payee Bank Account 

Details to be added by click Bank Icon.  Once Payee’s bank account details are updated / added 

as per figure 4.4.7.5 

 

 

Figure 4.117 Payee Bank Account Details 

 

Figure 4.118 Approve payee 

• To View Payees Entries, click on View Tab 

• To add /update Payee Bank Account Details click on  icon,  

• Enter Payee’s Bank Account Number, Bank Account Name & Banks IFSC Code 

• Click on Save button to Save Account Details for Payee 

• To the details, click on the “pencil”  icon  

• To Apply updates / modification Click on Modify Button 



Works and Accounts Management Information System, User Manual  

     

169 
 

• To delete the entry, click on the “delete  icon”  

• Click on  to cancel added bank account details, to makes the tat bank account 

details INACTIVE 

 

 

 

Figure 4.119  Approve payee account details 

• To the details, click on the “”  icon link 

• To save the modified values click on the “update” Button 

• To delete the entry, click on the “delete  icon” Link 

• To approve the entry, click on the “tick mark  icon” Link. 

• To accept the entry, click on Approve Button 

• Divisional Officers have the privilege to, delete, approve and cancel bank account 

details. 

 

Map Existing Payee 

 

Click the ‘Map Existing Payee’ tab to view the payees to be mapped, the division office can 

map a payee that has already been added by another division. This functionality allows users 

to use the same payee. 

 

Click the toggle button in Map column switch to map the existing payee details. When it is 

turned on, a payee mapping confirmation alert will be displayed as shown in the figure 

4.4.7.7 

Check the payee details and click the Map button to map the payee. 
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4.4.8. HSN/SAC 

 

Figure 4.122 Add HSN/SAC 

Figure 4.4.7.8 Map Payee 

Figure 4.4.7.7 Map Existing Payee 
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• On the left side main menu bar, locate and click on the WMS module (already selected in 

the image). 

• Under the WMS module, find and click on the Master dropdown (already expanded in the 

image). 

• From the Master dropdown, click on HSN/SAC to open the HSN/SAC management page   

• On the HSN/SAC page, User can see two tabs: Add and View. Click on the Add tab 

(already selected in the figure 4.4.8.1) to start adding new HSN/SAC details. 

 

Field Description: 

Field Name Mandatory Description Validation 

HSN/SAC 

Code 

Yes Enter the 

appropriate 

code to classify 

goods (HSN) or 

services (SAC). 

Must be a valid 

Alphanumeric code; 

typically, 4 to 10 

characters only.no special 

characters are allowed 

Description Yes Description of 

goods/services 

linked to the 

HSN/SAC code. 

Alphanumeric; max 250 

characters; cannot be 

blank. 

Goods / 

Services 

Yes Radio button to 

select whether 

the code 

applies to 

goods or 

services. 

Must choose either 

"Goods" or "Services". 

GST Rate 

(%) 

Yes Total GST 

applicable for 

the 

item/service 

Numeric; range between 

0–100; up to 2 decimal 

places. 
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(e.g., 18%, 

28%). 

SGST Rate 

(%) 

Yes State GST rate, 

typically half of 

GST rate (e.g., 

9% if GST is 

18%). 

Numeric; auto or manual; 

range between 0–50. 

CGST TDS 

Rate (%) 

Yes CGST TDS 

deduction rate 

(e.g., 1%) if 

applicable. 

Numeric; range 0–5; up to 

2 decimal places. 

SGST TDS 

Rate (%) 

Yes SGST TDS 

deduction rate 

(typically same 

as CGST TDS). 

Numeric; range 0–5; up to 

2 decimal places. 

Effective 

From Date 

Yes The date from 

which this tax 

configuration 

becomes 

applicable. 

Date format: DD-MM-

YYYY; must be a valid 

current or future date. 

Effective To 

Date 

No The Date  The Effective to Date for 

expiration of HSNSAC 

code to be valid date 

save Yes Click the 

button to save  

Button would be clickable 

after enter values for 

mandatory fields 



Works and Accounts Management Information System, User Manual  

     

173 
 

Steps to View and Approve HSN/SAC Details 

1. Go to the View Tab: 

o On the HSN/SAC page, click on the View tab (next to the Add tab) to see the list 

of added HSN/SAC entries. 

2. Locate the Added Entry: 

o In the View tab, user will see a table listing all HSN/SAC codes, their descriptions, 

tax rates, and status. Find the entry user just added (it might show a "Pending 

Approval" status if approval is required). 

3. Approve the Entry: 

o Depending on the system’s workflow, there might be an Approve button or option 

next to the entry (this isn’t visible in the image since we’re in the Add tab). Click 

Approve to confirm the details and make the HSN/SAC code active for use in the 

system.  

Figure 4.4.8.2 View HSN/SAC 
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4.4.9. Unit of Measurements 

Unit of Measurement (UOM) specifies the standard unit in which the quantity of a work item is 

measured and recorded. This may include units such as cubic meter (cum), square meter 

(sqm), running meter (rm), etc. 

To add a new Unit of Measurement, follow the navigation: WMS → Masters → Unit of 

Measurement. 

 

Figure 4.124 Add UOM 

Field Description: 

Field Name Mandatory Description Validation 

UOM Name Yes Enter the appropriate 

Unit of Measurement in 

Short Form 

Must be valid 

Alphabets  

UOM 

Description 

Yes Description of Unit of 

Measurement in Detail 

Alphanumeric; max 

250 characters; 

cannot be blank. 

Save Yes To Save UOM Details Confirmation 

Message would be 

displayed 
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Reset No To  All the values from 

input field to be 

cleared 

Steps to View and Approve Unit of Measurement (UOM) Details 

• Go to the View Tab: On the Unit of Measurement page, click on the View tab 

(already selected in the image) to see the list of UOM entries. 

• Locate the Entry to Approve: 

In the View tab, user can see a table with columns: UOM Name, UOM Description, 

Status, Actions, and Audit Details Look for entries with the status as any one of 

the following statuses REGISTERED/ MODIFIED, this status would indicate a 

newly added or ed entry awaiting approval. 

• Approve the Entry: 

In the Actions column, for an entry with MODIFIED/REGISTERED status, user can 

see a blue Approve button  

Click the Approve button to confirm the entry. Once approved, the status will 

change to APPROVED  
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Field Description: 

Field Name Mandatory Description Validation 

UOM Name Yes Enter the 

appropriate Unit of 

Measurement in 

Short Form 

Must be valid 

Alphabets  

UOM 

Description 

Yes Description of Unit 

of Measurement in 

Detail 

Alphanumeric; max 

250 characters; 

cannot be blank. 

Status No Display Status 

about approval for 

Newly added UOM 

entry 

If UoM added newly 

then REGISTERED 

If Modified Then 

MODIFIED 

If Rejected during 

Approval then status 

is REJECTED 

If UoM is Approved 

after registration / 

Modification the 

status is APPROVED 

If UoM is Cancelled 

after Approval then 

status is CANCELED 

Actions Yes  To, Cancel and 

Approve UOM 

entries 

Click on Tick Mark 

icon to Approve the 

UOM 
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Auditing No Auditing contains 

log details about 

the actions 

performed by 

admin users on the 

UoM, which is 

useful for tracking 

and auditing 

purposes 

 

 

 

4.5. User Management -UM Module 

4.5.1. User Creation 
  

This module facilitates user creation and assigns appropriate respective roles to users  

 

Login to the respective master admin via the respective department master admin user 

account 

 

Step-by-step instructions with Screenshots  

Go to UM Module--> Manage Users --> User this screen displays the User Creation 

Master screen as shown in the figure 4.5.1.1. 

 

Click on the User in list of menu options to display the Add and View User screen. From there, 

select the Add tab to create new users. 

Figure 4.5.1.1 UM Module screen 
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Enter all the fields, including the mandatory. After all the details are saved, click on the 

View tab to assign roles to the created users. 

 

Figure 4.126 Add User 

Field Description 

Field Name Mandatory Description Validation 

User ID Yes It is a user enterable field Enter the User Id and 

it allows max 50 

character 

Is Employee No if the user is employee, select 

the Designation from the drop-

down list populated HRMS 

master. 

Click check box. 

If the check box is 

selected, a new 

‘Employee’ field will 

appear after the 

‘Designation’ field.” 

Designation Yes It is a user selectable drop-

down field 

Select the 

Designation from the 

drop down 

Name Yes It is a user enterable field. Enter the name in 

Alphabet with 

maximum size of 99 

characters, only . & _ 
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are allowed. 

Company/Organisati

on 

No It is a user enterable field. Enter the 

Company/Organisati

on 

Email 

 

No It is a user enterable field. Enter the Email 

Contact No. 

 

No It is a user enterable field. Enter the Contact No. 

Valid From Yes It is a user 

enterable/Selectable field. 

From the date user id is active 

Select the date and 

date should be 

current or future 

date. 

Valid Till No It is a user 

enterable/Selectable field. To 

select user account validity 

end date as Validity Till 

Select the date or 

enter date as future 

date from date 

selected in Valid 

From in the format 

DD/MM/YYYY  

Password Yes It is a user enterable field. Password should 

have 8 to 32 

Characters, at least 1 

Capital letter,1 Small 

letter,1 number and 

1Special Caracter 

Confirm Password Yes It is a user enterable field. Enter the Confirm 

password as same as 

Password 

Save Yes Click the save button to save 

the users 

Save button is 

enabled only when all 

mandatory fields are 

filled 

Reset  Click the reset button to clear 

the user details 

User details get 

cleared. 
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Click the View tab, then click the 'Search in Users' button to filter a specific user by 

entering any of the fields as shown in figure 4.5.1.4  

Click the search button you can see the user as shown in below figure 4.5.1.5

 

Figure 4.128 Search user in list of users 

Select/Click on the Checkbox against the User ID to assign roles. Once the checkbox is 

selected, the 'Assign Roles to Selected User' button at the top of the table will be visible, as 

shown Figure 4.5.1.5. 

Roles to be assigned to user 

1. Open UM Module → Manage Users → Users → View. 

2. Locate the user(s) you want to update/ assign role. 

Figure 4.5.1.3 View User 
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3. Click the checkbox to the left of the User ID for each user you want to modify. 

4. Click the Assign Roles to Selected Users button. 

5. In the dialog that appears, set the scope fields: Administration, Region, Cir-

cle, Division, Subdivision, and Section. 

o These are usually dropdowns choose the appropriate value for each. 

6. Click Select to confirm those scope values. 

7. Switch to the Roles tab to find out defined roles already exist. 

8. For each role you want to inspect, click the role’s  icon to view the role’s 

functionality and which screens the role grants access to. 

9. In the Roles tab, under the Select column, click the Assign checkbox (tick 

mark) next to each specific role to assign it to the selected user(s). 

10. After choosing roles, click it (whichever button your UI displays) to apply the 

changes. 

11. After clicking Assign, a confirmation alert will appear. Click the OK button to confirm 

the role assignment 

12. Verify the assignment: look for a confirmation message (e.g., Roles assigned 

successfully) and check the user’s profile or the Assigned Roles column to 

confirm the roles are listed. 

13. To change password for the user, click on key icon  

14. To Activate/Inactivate the user using click toggle  button under 

Active/Inactive column 

15. To edit user information, click on pencil  icon 

16. To Delete User ID from User master, click on  Trash icon 

17. To verify the roles assigned to user by click menu icon in the column View Role 

Assignments 

18. To unlock locked User ID due to multiple attempts of failed login, click on  

toggle icon in Unlock column 
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Figure 4.130 Confirm Role Assignment 

 

Change User’s Password:  

1. To Change password of the user, select user by click on the check box against the 

user id, then click on Key icon  

2. Change password window will be appeared over the screen 

3. Selected User ID would be auto populated in user id field 

4. Enter Password and Confirm Password 

Figure 4.5.1.5 Assigning Role to User 
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5. Now Save button will be enabled, then click on save button to save password 

 

Figure 4.131 Change password for user 

Unlock User ID: 

A User entered login credentials more than 3 times the user id will be locked. To unlock that 

user id master admin user has to select the locked user id by click on check box and click on 

toggle button in locked state under Unlock column as shown in Figure 4.5.1.9 

 

Figure 4.132 Unlock locked user id 
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4.6. Master 

4.6.1. Jurisdiction Master 

This module facilitates the creation of Jurisdiction Master data as mentioned below, 

which are added by Master Administrator Login Only 

• State 

• District 

• Office 

 

Login to the respective master admin via the respective department master admin  

 

Step-by-step instructions with Screenshots  

Go to Master --> Jurisdiction --> State this screen displays the “State” Master screen 

as shown in the figure 4.6.1.1. 

1. State 

 

Figure 4.133 Master data creation for State 

Click on the State menu button to see the Add and View screens after that click the Add 

button to add a new state. 



Works and Accounts Management Information System, User Manual  

     

185 
 

Enter the State Name in the field; it is mandatory. After filling the State field, the Save 

button will be enabled.  

Click the Save button to save the state name details. 
                                                                                   

Field Description 

Field Name Mandatory Description Validation 

State Name Yes It is a user enterable 

field 

Enter the State Name 

and it allows max 100 

characters Only 

Alphabets 

LGD CODE Yes It is a user enterable 

field 

2-digit Number only 

acceptable 

Save Yes Clickable Button Once all required fields 

are filled with required 

Data Then only Button 

Enabled 

Reset No Clickable button to 

remove text from all 

the input fields 

Reset should be clicked 

before Save  

 

After saving the state name, click the View tab to see the newly added state name. 

In the View section, there is a search option for states. Click on Search to view state details 

by entering fields such as State Name and selecting the Status from the dropdown list. 

The available status options are: DRAFT, REGISTERED, MODIFIED, FINALIZED, and 

REJECTED.As shown in Figure 4.6.1.3, the View section also includes actions to edit, delete, 

and approve state details, as follows: 

• Click the Edit  icon to update the state data. 

Figure 4.134  Adding State  
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• Click the Delete  icon to remove the entered state data. 

• Click the Tick mark  icon to approve or finalize the entered office data. 

• Click the  icon to discard the changes. 

 

 2.District 

Go to Master --> Jurisdiction --> District this screen displays the “District” Master 

screen as shown in the above figure 4.6.1.4. 

Click on the District menu button on the same screen above to see the Add and View 

screens of district. 

Click the Add tab to add district details. Fill in all the mandatory fields: Name and State. 

Figure 4.135 View Screen 

Figure 4.136 Add District Screen 
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After filling the Name field, the Save button will be enabled.  

Click the Save button to save the district name details. 

Below the Save button, there are options to Download Excel and Upload Excel. 

Click the Download Excel button to download the Excel template, and after filling it, click 

the Upload Excel button to upload it. 

 

Field Description 

Field Name Mandatory Description Validation 

Name Yes Enter District Name 

to be added newly as 

a Single Entry 

Enter the District 

Name and it allows 

max 100 characters 

Only Alphabets 

LGD CODE Yes It is a user enterable 

field LGD Code 

Relevant 

3-digit Number only 

acceptable 

Save Yes Clickable Button Once all required 

fields are filled with 

required Data Then 

only Button Enabled 

Reset No To Clear / Erase filled 

Data 

Use only when 

correction required 

before saving data 

Download  
No To Download 

Template as Excel file 

 

Figure 4.137 Excel template for Add Districts 
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Upload No To Upload District 

Information as bulk 

data 

Must be Upload the 

excel file with valid 

Data Entered 

Manually 

Click the View tab to see the newly added district master details from the Add screen. 

 

  3. Office 

Go to Master --> Jurisdiction --> Office this screen displays the “Office” Master 

screen as shown in the above figure 4.6.1.7 

Figure 4.138 View District screen 

Figure 4.139 Adding Office 
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Click on the Office menu button on the same screen above to see the Add and View 

screen. Click the Add tab to add office details. Fill in all the mandatory and click on the 

save button. 
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Field Description: 

 

Field Name Mandatory Description Validation 

Office Name Yes It is a user enterable 

field. 

Enter the name and it 

allow max 125 

characters. 

Office Level Yes It is user selectable 

drop down 

Select the office level 

from the drop-down 

list 

Address Yes It is a user enterable 

field. 

Enter the address; a 

maximum of 300 

characters is allowed. 

State Yes It is user selectable 

drop down 

Select the State from 

the drop-down list. 

District Yes It is user selectable 

drop down 

Select the District 

from the drop-down 

list 

Phone No It is a User enterable 

field. 

Enter the number. 

Email No It is a User enterable 

filed. 

Enter the mail Id 

Creation Order 

Number 

 

No It is a User enterable 

field 

Enter the number and 

enter the order 

number a maximum 

50 digits are allowed. 

Creation Order 

Date 

Yes It is a User enterable 

and selectable field. 

Enter or select the 

date  

Creation Date 

 

Yes  It is a User enterable 

and selectable field. 

Enter or select the 

date  

Authority No It is a User enterable 

filed. 

Enter the authority a 

maximum 

50mcharacters are 

allowed 

State Region  No  It is a User selectable 

field 

Select the region. 

HRMS-ID No It is a User enterable 

field  

Enter the HRMS ID. 

Click the Save button to save the office details. Once saved, the office details will be 

displayed on the View screen. 
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Click the View tab to see the newly added office master details from the Add screen. 

Click Search Office Records and enter the necessary fields to filter the office records. 

 

 Field Description: 
 

Field Name Mandatory Description Validation 

Office Name   No It is a user enterable 

field. 

 Enter the particular 

office name   

Parent office 

name 

No It is a user enterable 

field. 

Enter the particular 

parent office name   

Office level  No It is user selectable 

drop down 

Select the office level 

from the drop-down 

list 

Office status No It is user selectable 

drop down 

Select the office 

status from the drop-

down list 

Status  No It is user selectable 

drop down 

Select the status from 

the drop-down list 

Search  No Click the search 

button to get the data 

         - 

Reset  No  Click the reset button 

the entered fields get 

cleared  

          - 

 

In the below screen, the Action tab contains icons like Edit, Delete, Finalize, and Cancel. 

Figure 4.140 View Offices 
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• Click the Edit  icon to update the office data. 

• Click the Delete  icon to remove the entered office data. 

• Click the Tick mark  icon to approve or finalize the entered office data. 

• Click the Cancel  icon to discard the changes. 

 


